Chapter 3  Checking Printer Status and Managing Print Jobs for Windows

Using the Progress Meter ........................................ 3-2
Using EPSON Spool Manager .................................... 3-3
Using EPSON Status Monitor 3 .................................. 3-4
  Accessing EPSON Status Monitor 3 ......................... 3-4
  Viewing information in EPSON Status Monitor 3 ......... 3-5

Chapter 4  Using the Printer Software for Macintosh

Printer Software Introduction ................................ 4-2
Making Changes to Printer Settings ......................... 4-2
Making the Media Type setting ................. 4-3
Using the Automatic mode ....................... 4-7
Using the PhotoEnhance mode .................... 4-7
Using the Custom mode .......................... 4-8
Using the Advanced settings ..................... 4-9
Changing the page setup ......................... 4-12
Setting the Print Time ............................ 4-15
Modifying the page layout ....................... 4-16
   Fitting your document to the paper size ......... 4-17
   Printing a watermark on your document .......... 4-17
   Printing two or four pages on one sheet ......... 4-19
   Printing posters .................................. 4-20
Previewing your printout ......................... 4-21
   Saving print data in files ....................... 4-23
Using the Printer Utilities ....................... 4-24
   EPSON StatusMonitor ............................ 4-24
   Nozzle Check .................................... 4-24
   Head Cleaning ................................... 4-25
   Print Head Alignment ............................ 4-25
   Configuration .................................... 4-25

Chapter 5 Checking Printer Status and Managing Print Jobs for
Macintosh

Using EPSON StatusMonitor ....................... 5-2
   Accessing EPSON StatusMonitor .................. 5-2
   Making Configuration Settings .................. 5-3
Using EPSON Monitor3 .............................. 5-5
   Accessing EPSON Monitor3 ....................... 5-5
   Managing print jobs with EPSON Monitor3 ....... 5-6
   Changing the priority of print jobs .............. 5-7

Chapter 6 Setting Up Your Printer on a Network

For Windows 98 and 95 Users ..................... 6-2
   Setting up your printer as a shared printer ....... 6-2
   Accessing the printer through a network ......... 6-4
Chapter 7 Replacing Ink Cartridges

Replacing an Ink Cartridge ........................................ 7-2
  Using the printer's control panel .......................... 7-2
  Using the Status Monitor 3 .............................. 7-7
Replacing an Old or Damaged Ink Cartridge ......................... 7-8

Chapter 8 Maintenance

Checking the Print Head Nozzles ............................... 8-2
  Using the Nozzle Check utility .......................... 8-2
  Using the control panel buttons .......................... 8-3
Cleaning the Print Head ........................................ 8-4
  Using the Head Cleaning utility ......................... 8-5
  Using the control panel buttons ......................... 8-8
Aligning the Print Head ........................................ 8-9
Cleaning the Printer ............................................. 8-10
Transporting the Printer ........................................ 8-11
Updating Software .............................................. 8-12
  Updating to Windows 98 ................................... 8-13
  Updating the driver in Windows NT 4.0 .................. 8-13

Chapter 9 Troubleshooting

Diagnosing the Problem ........................................ 9-3
  Error indicators .............................................. 9-4
  Status Monitor 3 ............................................. 9-5
  Running a printer operation check ....................... 9-5
Cancelling Printing ................................................ 9-8
Chapter 10 Consumable Products

Consumable Products ........................................... 10-2

Appendix A Tips for Color Printing

BA-asics of Color .................................................. A-2
Image Resolution and Image Size .......................... A-5
Appendix B  Printer Specifications

Printing .......................................................... B-2
Paper ............................................................. B-2
   Paper specifications ....................................... B-3
   Printable area .............................................. B-5
Ink Cartridges .................................................... B-7
Safety Approvals ................................................ B-10
System Requirements .......................................... B-11
   For PCs ..................................................... B-11
   For Macintosh computers ............................... B-11

Glossary
Unpacking the Printer

Your printer box should include a CD-ROM containing printer software that runs your printer, and the items shown in the illustration.

In some locations, the power cord comes attached to the printer. The shape of the AC plug varies by country; be sure the plug included is the right shape for your location.

Remove all protective materials packed with your printer before setting up and turning on the printer. Follow the instructions inserted with the printer to remove these materials. Save all packaging and protective materials for transporting the printer in the future.
Printer Parts and Control Panel Functions

- paper support
- edge guides
- output tray
- printer cover
- output tray extension
- sheet feeder

- ink cartridge clamps
- Print head
- adjust lever
- control panel
## Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
</table>
| ![power] | Turns the printer on and off.  
Clears the printer's memory if pressed twice while the power is on. |
| ![load/eject] | Loads or ejects paper if pressed and released within 2 seconds.  
Resumes printing if pressed and released after a paper out error. |
| ![cleaning] | Moves the print head to the ink cartridge replacement position if pressed for 3 seconds while the black or color ink out light is flashing or on.  
Returns the print head to its home position after ink cartridge replacement.  
Performs print head cleaning if held for 3 seconds when the black or color ink out light is off. |

## Lights

<table>
<thead>
<tr>
<th>Light</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![power] | On when the printer is on.  
Flashing when printer is receiving data, printing, replacing an ink cartridge, charging ink, or cleaning the print head. |
| ![paper out] | On when the printer is out of paper. Load paper in the sheet feeder, then press the load/eject button to resume printing.  
Flashing when the paper is jammed. Take all of the paper out of the feeder, then reload the paper. If the light continues to flash, turn off the printer and gently pull all the paper out of the printer. |
| ![black ink out] | On when the black ink cartridge is empty. Replace the black ink cartridge.  
Flashing when the black ink cartridge is nearly empty. |
| ![color ink out] | On when the color ink cartridge is empty. Replace the color ink cartridge.  
Flashing when the color ink cartridge is nearly empty. |
Safety Instructions

Important Safety Instructions

Read all of these instructions before using your printer. Also be sure to follow all warnings and instructions marked on the printer.

- Do not block or cover the openings in the printer’s cabinet. Do not insert objects through the slots.
- Take care not to spill liquid on the printer.
- Use only the type of power source indicated on the printer’s label.
- Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Avoid electrical outlets controlled by wall switches or automatic timers.
- Keep the entire computer system away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
- Do not use a damaged or frayed power cord.
- If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
- Do not attempt to service the printer yourself.
Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the cabinet damaged; the printer does not operate normally or exhibits a distinct change in performance.

A Few Precautions

Note the following when setting up, using, and handling the printer and ink cartridges.

When using the printer

- Do not put your hand inside the printer or touch the ink cartridges during printing.
- Do not move the print head by hand; otherwise, you may damage the printer.
- Always turn the printer off using the power button. When this button is pressed, the power light flashes briefly then goes off. Do not unplug the printer or turn off the power to the outlet until the power light stops flashing.
- Before transporting the printer, make sure the print head is in the home (far right) position and the ink cartridges are in place.

When handling the ink cartridges

- Keep ink cartridges out of the reach of children. Do not allow children to drink from or otherwise handle the cartridges.
- If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets in your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

- Do not shake an ink cartridge; this can cause leakage.

- Install the ink cartridge immediately after you remove it from its package. If you leave a cartridge unpacked for a long time before using it, normal printing may not be possible.

- Do not use an ink cartridge beyond the date printed on the cartridge carton: otherwise, it may result in reduced print quality. For best results, use up the ink cartridges within six months of installing them.

- Do not dismantle the ink cartridges. This could damage the print head.

- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

- Store ink cartridges in a cool, dark place.

**When choosing a place for the printer**

- Place the printer on a flat, stable surface that is larger than the printer. The printer will not operate properly if it is tilted or at an angle.

- Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct sunlight, strong light, or heat sources.

- Avoid places subject to shocks and vibrations.

- Leave enough room around the printer to allow for sufficient ventilation.
Place the printer near a wall outlet where the plug can be easily unplugged.

---

### ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

The International ENERGY STAR Office Equipment Program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.

---

### Warnings, Cautions, and Notes

- **Warnings**
  must be followed carefully to avoid bodily injury.

- **Cautions**
  must be observed to avoid damage to your equipment.

**Note:**
contain important information and useful tips on the operation of your printer.
Chapter 1

Paper Handling

Loading Plain Paper ........................................ 1-2

Loading Special Paper and Other Media .................. 1-3
  About special media cleaning sheets ..................... 1-6

Loading Envelopes .......................................... 1-6

Using EPSON Photo Paper (4 x 6 inch, 200 x 300 mm) .... 1-7
  Loading Photo Paper ...................................... 1-8
  Removing the perforated margins ......................... 1-9
  Storing EPSON Photo Paper .............................. 1-11
Loading Plain Paper

Follow the steps below to load plain paper in the printer.

1. Lower the output tray and slide out the extension. Next, slide the left edge guide so that the distance between the edge guides is slightly wider than the width of your paper.

   If you load long paper (for example, legal size paper), pull up the paper support extension.

2. Fan a stack of paper, then tap it on a flat surface to even the edges.

3. Load the stack of paper with the printable side up and the right edge of the paper resting against the right side of the sheet feeder. Then slide the left edge guide against the left edge of the paper.

   Note:
   - Always load paper into the sheet feeder short edge first.
   - Make sure the paper stack fits under the arrow mark inside the edge guide.
**Loading Special Paper and Other Media**

You can achieve good results with most types of plain bond paper. However, coated paper and glossy film result in higher quality printouts because these media absorb smaller amounts of ink.

EPSON provides special media that are formulated for the ink used in EPSON ink jet printers. EPSON recommends using media distributed by EPSON to ensure high-quality results. See “EPSON special media” on page 10-2 for a complete list of these products.

When loading special media distributed by EPSON, read the instruction sheets packed with the media first and keep the following points in mind.

- Make sure the printable side of the paper is facing up when loading media into the sheet feeder. See the instruction sheets packed with the media to determine which side is the printable surface. Some media have cut corners to help identify the correct loading direction, as shown in the illustration.

**Note:**
If you extend the printable area by selecting the Maximum setting in the printer driver, the cut corner on special paper may mar your printout.
- Make sure the paper stack fits under the arrow mark located on the inside surface of the left edge guide.

- The loading capacity for EPSON special media is explained below.

<table>
<thead>
<tr>
<th>Special Media</th>
<th>Loading Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>360 dpi Ink Jet Paper and Photo Quality Ink Jet Paper</td>
<td>Up to the arrow mark on the left edge guide.</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Cards, Ink Jet Note Cards, and Ink Jet Greeting Cards</td>
<td>Up to 30 index cards. Always place the included support sheet* under the cards.</td>
</tr>
<tr>
<td>Photo Quality Glossy Film</td>
<td>One sheet at a time. Always put a support sheet* or a sheet of plain paper under the glossy film. If you wish to load multiple sheets, set the minimum top margin of the page to 30 mm and load a maximum of 20 sheets for A4.</td>
</tr>
<tr>
<td>Ink Jet Transparencies</td>
<td>Up to 30 transparencies. Always put a sheet of plain paper under the stack of transparencies.</td>
</tr>
<tr>
<td>Photo Quality Self Adhesive Sheets</td>
<td>One sheet at a time.</td>
</tr>
<tr>
<td>Photo Paper</td>
<td>Up to 20 sheets. For 200 x 300 mm Photo Paper, you can only load one sheet at a time. Always put a support sheet* under the stack of Photo Paper.</td>
</tr>
<tr>
<td>Photo Stickers 16 and Photo Stickers 4</td>
<td>One sheet at a time. Always put the included support sheets* A and B under the stack of Photo Stickers.</td>
</tr>
<tr>
<td>Matte Paper-Heavyweight</td>
<td>Up to 20 sheets. Always put a support sheet* under the stack of Matte Paper-Heavyweight.</td>
</tr>
</tbody>
</table>

* Take care not to print on support sheets loaded under special media.
When you are using Photo Quality Glossy Film or transparencies, remove each sheet from the output tray as it is printed.

If the paper is curled, be sure to flatten it or curl it slightly toward the opposite side before loading. Printing on curled paper may smear your printout, especially when printing with Maximum selected as the Printable Area setting.

If ink smears on your documents when printing on thick media, set the adjust lever to the “+” position. To change the setting, open the printer cover and position the lever as shown in the illustration.

Note:
Return the adjust lever to the “0” position before printing on media of normal thickness. Leaving the lever in the “+” position may cause gaps in the printed image.
When the adjust lever is in the “+” position, make sure the High Speed setting in the printer driver’s Advanced dialog box is off. To turn this option off, you may also need to change the Print Quality setting or align the print head using the Print Head Alignment utility.

If you wish to print on the reverse side of an Ink Jet Card with Maximum selected as the Printable Area setting, flatten the cards or curl them slightly toward the opposite side before loading. Set the adjust lever to the “+” position before printing.

About special media cleaning sheets

Cleaning sheets packaged with EPSON special media should not be used with this printer. The cleaning function performed by these sheets is not necessary with this type of printer, and the sheets could jam in the printer.

Loading Envelopes

When printing on envelopes, please note the following:

- You can load up to 10 envelopes into the sheet feeder.

  **Note:**
  The folding quality and thickness of envelopes varies widely. If the total thickness of the stack of envelopes exceeds 10 mm, press each envelope in the stack flat before loading.

- Set the adjust lever to the “+” position. To do this, open the printer cover and reposition the lever.
Note:
- Return the adjust lever to the “0” position, which is the normal position, after you finish printing on envelopes. Leaving the lever in the “+” position may cause gaps to appear in images printed on other media.
- When the adjust lever is in the “+” position, make sure the High Speed setting in the printer driver’s Advanced dialog box is off. To turn this option off, you may also need to change the Print Quality setting.
- Load envelopes flap edge first with the flap side down, as shown in the illustration.
- Do not use envelopes that are curled or folded. Make sure to flatten the envelope flaps before loading. Also avoid using envelopes that are too thin; they may curl during printing.
- Select Plain Paper as the Media Type setting in the printer driver.

Using EPSON Photo Paper (4 x 6 inch, 200 x 300 mm)

EPSON Photo Paper (S041134, S041254) is perforated around the margins so you can trim your printed images to look like 4 x 6 inch (102 x 152 mm) or 200 x 300 mm photographs.
**Loading Photo Paper**

Note the following when loading EPSON Photo Paper.

- Load the paper printable side up with the perforated margins positioned as shown in the illustration.

- Use flat, undamaged paper. If the paper or the support sheet is curled, flatten it before loading to avoid paper feeding problems.

- Always place the included support sheet under the stack of Photo Paper, but do not print on it.

- You can load up to 20 sheets of 4 × 6 inch Photo Paper or one sheet of 200 × 300 mm Photo Paper into the sheet feeder.

- Do not fold the paper before printing.

- Cut or tear the paper at the perforation only after printing.

- Select Photo Paper as the Media Type setting and Photo Paper 4 × 6 in or Photo Paper 200 × 300 mm as the Paper Size setting in your printer driver.
Removing the perforated margins

Note the following when removing the perforated margins.

- To remove the perforated margins, fold the paper back and forth a few times along the perforations, then carefully tear the margins off.

- You can also remove the margins by cutting along the perforations.

Note:
Keep in mind that the edges of your image might be cut off when you remove the perforated margins. See the illustrations below.
4 x 6 inch

200 x 300 mm
Storing EPSON Photo Paper

Keeps the following points in mind when storing Photo Paper.

☐ Return unused paper to the original package as soon as you finish printing, and avoid storing it in places exposed to high temperature, humidity, or direct sunlight.

☐ EPSON recommends storing your printouts in a resealable plastic bag and keeping them away from high temperature, humidity, and direct sunlight.
Chapter 2

Using the Printer Software for Windows

2-Printer Software Introduction ........................................... 2-3
Getting more information ...................................................... 2-3
Accessing the printer software .............................................. 2-3

Making Changes to Printer Settings ........................................ 2-4
Making the Media Type setting .............................................. 2-5
Using the Automatic mode ..................................................... 2-8
Using the PhotoEnhance mode ............................................... 2-9
Using the Custom mode ......................................................... 2-11
Using the Advanced settings .................................................. 2-12

Modifying the printout style ................................................. 2-15
Making the Paper menu settings ............................................ 2-16
Fitting your document to the paper size .................................. 2-17
Printing two or four pages on one sheet .................................. 2-18
Printing posters ..................................................................... 2-19
Printing a watermark on your document .................................. 2-20

Previewing your printout ....................................................... 2-23

Using the Printer Utilities ....................................................... 2-26
Status Monitor 3 ..................................................................... 2-27
Nozzle Check ......................................................................... 2-27
Head Cleaning ......................................................................... 2-28
Print Head Alignment ............................................................. 2-28
Printer and Option Information ............................................... 2-28
Speed & Progress .................................................................... 2-30
Monitoring Preferences ......................................................... 2-32

Getting Information Through Online Help ............................. 2-33
Accessing help from your application ..................................... 2-33
Accessing help from the Windows Start menu ......................... 2-33

Increasing the Print Speed ...................................................... 2-33
General tips ........................................................................... 2-34
Using Speed & Progress ......................................................... 2-36
Using Port Configuration (Windows NT 4.0 only) . . . . . 2-39
Printer Software Introduction

The printer software which comes with your printer includes a printer driver and printer utilities. The printer driver lets you choose from a wide variety of settings to get the best results from your printer. The printer utilities help you check the printer and keep it in top condition.

Getting more information

For information on using the printer driver, see “Making Changes to Printer Settings” on page 2-4.

For information on using the printer utilities, see “Using the Printer Utilities” on page 2-26.

Note: The specific features available in the printer software vary depending on the version of Windows you are using.

Online help provides more information about the printer software. See “Getting Information Through Online Help” on page 2-33 for instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows applications, or from the Windows Start menu (Windows 98, 95 and NT 4.0).

When you access the printer software from a Windows application, the settings you make apply only to the application you are using.

When you access the printer software from the Start menu, the settings you make apply to all of your Windows applications.
From Windows applications

1. From the File menu, click Print or Print Setup.

2. In the dialog box that appears, click Printer, Setup, Options, or Properties. (Depending on your application, you may need to click a combination of these buttons.) The printer driver opens.

From the Windows Start menu

1. Click Start, point to Settings, then click Printers.

2. For Windows 95 and 98, select your printer, then click Properties on the File menu. For Windows NT 4.0, select your printer, then click Document Defaults on the File menu. The printer driver opens.

Making Changes to Printer Settings

The printer driver features the following menus and settings.

Main: Media Type, Ink, Mode

Paper: Paper Size, Copies, Orientation, Printable Area

Layout: Reduce/Enlarge, Multi-Page, Watermark

The Mode settings on the Main menu are arranged to give you four levels of control over the printer driver, as explained below.

<table>
<thead>
<tr>
<th>Automatic</th>
<th>This mode provides the quickest and easiest way to start printing. See “Using the Automatic mode” on page 2-8.</th>
</tr>
</thead>
</table>
In addition to making comprehensive Mode settings that affect overall print quality, you can also modify individual aspects of your printout using the Paper and Layout menus. See “Modifying the printout style” on page 2-15.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PhotoEnhance</td>
<td>This mode lets you choose from a variety of image-correction settings specially designed for photos. See “Using the PhotoEnhance mode” on page 2-9.</td>
</tr>
<tr>
<td>Custom</td>
<td>This mode lets you choose from a list of ready-made or personalized settings suited to the kind of document you want to print. When Custom is selected, the Advanced button is enabled, allowing you to access the Advanced dialog box. See “Using the Custom mode” on page 2-11.</td>
</tr>
<tr>
<td>Advanced</td>
<td>This button opens the Advanced dialog box, where you can make detailed settings to fit your individual needs. From the Advanced dialog box, you can add your personalized settings to the Custom Settings list. See “Using the Advanced settings” on page 2-12.</td>
</tr>
</tbody>
</table>

Making the Media Type setting

The Media Type setting determines what other settings are available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches the media which is loaded in the printer. To find out what Media Type you are using, find your media in the list below, and refer to the corresponding Media Type under which it is grouped (shown in larger type). For some media, there are several Media Type settings to choose from.
Plain Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4)  S041214

360 dpi Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4)  S041059
EPSON Iron-On Cool Peel Transfer Paper (A4)  S041154

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper (A4)  S041061
EPSON Photo Quality Ink Jet Cards (A6)  S041054
EPSON Photo Quality Ink Jet Cards (5 × 8”)  S041121
EPSON Photo Quality Ink Jet Cards (8 × 10”)  S041122
EPSON Photo Quality Self Adhesive Sheets (A4)  S041106
EPSON Ink Jet Note Cards A6 (with envelopes)  S041147
EPSON Ink Jet Greeting Cards 5 x 8” (with envelopes)  S041148
EPSON Ink Jet Greeting Cards 8 x 10” (with envelopes)  S041149

Matte Paper-Heavyweight

EPSON Matte Paper-Heavyweight (A4)  S041259
Photo Paper

EPSON Photo Paper (A4)  S041140
EPSON Panoramic Photo Paper (210 × 594 mm)  S041145
EPSON Photo Paper Cards (A4)  S041177

Photo Quality Glossy Film

EPSON Photo Quality Glossy Film (A4)  S041071
EPSON Photo Quality Glossy Film (A6)  S041107
EPSON Photo Stickers 16 (A6)  S041144
EPSON Photo Stickers 4 (A6)  S041176

Ink Jet Transparencies

EPSON Ink Jet Transparencies (A4)  S041063
Note:
The availability of special media varies by location.

Using the Automatic mode

When Automatic is selected as the Mode setting on the Main menu, the printer driver takes care of all detailed settings based on the current Media Type and Ink settings. To make the Ink setting, click Color to print in color, or Black to print in black-and-white or grayscale. To make the Media Type setting, see “Making the Media Type setting” on page 2-5.

Note:
- Depending on the media selected in the Media Type list (while Automatic is selected), a slider appears under the Custom radio button that lets you choose from Quality or Speed settings. Select Quality when print quality is more important than speed.
Most Windows applications feature paper size and page layout settings that override similar settings on the printer driver. However, if your application does not have these settings, verify the settings on the printer driver’s Paper menu.

**Using the PhotoEnhance mode**

The PhotoEnhance mode provides a variety of image-correction settings that you can apply to your photo images before printing. PhotoEnhance does not affect your original data.

Note:
- This mode is available when printing 16-, 24-, or 32-bit color data.
- Printing with PhotoEnhance selected may increase the time required for printing, depending on your computer system and the amount of data contained in your image.
You can select from the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard</strong></td>
<td>This setting provides standard image correction for most photos. Try this first.</td>
</tr>
<tr>
<td><strong>People</strong></td>
<td>This setting is best for photos of people.</td>
</tr>
<tr>
<td><strong>Nature</strong></td>
<td>This setting is best for outdoor scenery such as mountains, sky, and oceans.</td>
</tr>
<tr>
<td><strong>Soft Focus</strong></td>
<td>This setting makes your photos look as if they were taken with a soft-focus lens.</td>
</tr>
<tr>
<td><strong>Sepia</strong></td>
<td>This setting applies a sepia tone to your photos.</td>
</tr>
</tbody>
</table>

Selecting PhotoEnhance also enables the Digital Camera Correction check box. Select this check box when you are printing photos taken with a digital camera to give your printed images the smooth, natural appearance of photographs taken with a film camera.
Using the Custom mode

The Custom mode offers ready-made settings designed for printing text and graphs and for applying a color-matching method. You can also create and save your own custom settings. See “Using the Advanced settings” on page 2-12 for details.

You can select from the following ready-made settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text/Graph</td>
<td>This setting is good for printing presentation documents such as graphs and charts.</td>
</tr>
<tr>
<td>Economy</td>
<td>This setting is best for printing drafts of text</td>
</tr>
<tr>
<td>ICM</td>
<td>This setting automatically adjusts printout colors to match colors on your screen. ICM stands for Image Color Matching.</td>
</tr>
<tr>
<td>sRGB</td>
<td>This setting is best for color matching with other sRGB devices.</td>
</tr>
</tbody>
</table>

Follow the steps below to select a Custom setting.
1. Select Custom as the Mode setting on the Main menu.

2. Click anywhere in the list box to open it, then select the most appropriate setting for the type of document or image you wish to print.

3. When you select a Custom setting, other settings such as Print Quality, Halftoning, and Color Adjustment are made automatically. Changes to these settings are reflected in the display on the left side of the Main menu.

4. Before printing, be sure to verify the Media Type and Ink settings, as they may be affected by the Custom setting you select. See “Making the Media Type setting” on page 2-5.

**Using the Advanced settings**

The settings in the Advanced dialog box give you complete control over your printing environment. Use these settings to experiment with new printing ideas, or to fine-tune a range of print settings to meet your individual needs. Once you are satisfied with your new settings, you can give them a name and add them to the Custom Settings list on the Main menu.

**Making Advanced settings**

Follow the instructions below to make Advanced settings.

*Note:*
The printer driver screens that appear in this section are for Windows 98 and 95. Windows NT 4.0 printer driver screens differ only slightly.
1. Select Custom as the Mode setting on the Main menu and then click Advanced. The following dialog box appears.

![Advanced Settings Dialog Box]

2. Select the Media Type you loaded in the printer. For details, see “Making the Media Type setting” on page 2-5.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.

**Note:**

- *The PhotoEnhance option under Color Management only affects images, not text or graphs. For example, if Monochrome is selected from the Tone list (enabled when PhotoEnhance is selected), only the images in a document will be printed in monochrome. Any colored text or graphs in the same document will be printed in color.*

- *Some settings may be unavailable depending on the Media Type, Ink, and Print Quality settings you make.*
6. Click OK to apply your settings and return to the Main menu. If you want to return to the Main menu without applying your settings, click Cancel. To save your Advanced settings, see the next section.

**Saving and deleting your settings**

To save your Advanced settings in the Custom Settings list, click Save Settings in the Advanced dialog box. The Custom Settings dialog box appears.

Type a unique name for your settings in the Name box, then click Save. Your Advanced settings will be added to the Custom Settings list.

**Note:**
- You cannot apply the names of settings provided by EPSON to your custom settings.
- You cannot delete the ready-made settings from the Custom Settings list.

To delete a setting from the Custom Settings list, select the setting name in the Custom Settings dialog box and click Delete.
Using your saved settings

To select your settings, click the Custom button on the Main menu, then select your setting in the Custom Settings list, located to the right of the Custom button.

If you change the Media Type or Ink settings while one of your customized settings is selected in the Custom Settings list, the selection shown in the list returns to Custom Settings. The customized setting that was previously selected is not affected by the change. To return to your customized setting, simply reselect it in the list.

Modifying the printout style

You can modify your printout style using a variety of printer driver settings located on the Paper and Layout menus.

On the Paper menu, you can set the paper size, the number of copies, the orientation of your printout, and the printable area. On the Layout menu, you can automatically match the document size to the paper size, print two or four pages on a single sheet of paper, print poster-size images by enlarging one page to cover several sheets, or place watermarks on documents.
Making the Paper menu settings

Use the settings on the Paper menu to change the paper size, set the number of copies and other copy parameters, specify the paper orientation, and adjust the printable area.

You can make the following settings on the Paper menu:

<table>
<thead>
<tr>
<th>Paper Size/Page Size</th>
<th>Select the paper or page size you want to use. You can also add a custom paper size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies</td>
<td>Select the number of copies you wish to print. You can select Collate to print one set at a time or Reverse Order to determine the order in which you print multiple copies of your document.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Select Portrait (tall) or Landscape (wide) to change the orientation of your printout. If you need to print closer to the bottom of the page, select the Rotate by 180° check box.</td>
</tr>
</tbody>
</table>
Using the Printer Software for Windows

Fitting your document to the paper size

Use the Reduce/Enlarge options on the Layout menu to fit your document to the paper size you will print on.

You can select from the following settings.

| Normal | Prints your document at its normal size. |
Using the Printer Software for Windows

Printing two or four pages on one sheet

Select N-up as the Multi-Page setting on the Layout menu to print two or four pages of your document on one sheet of paper.

<table>
<thead>
<tr>
<th>Fit to Page</th>
<th>Proportionally enlarges or reduces the size of your document to make it fit the paper size you select in the Paper Size list on the Paper menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Allows you to manually reduce or enlarge an image. Click the arrows next to the Scale to box to select a percentage between 10% and 400%.</td>
</tr>
</tbody>
</table>

To print more than one page on the piece of paper, you should make the following settings:

<table>
<thead>
<tr>
<th>2 Pages</th>
<th>Prints two or four pages of your document on a single piece of paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Pages</td>
<td></td>
</tr>
</tbody>
</table>
Printing posters

A single document page can be enlarged to cover 4, 9, or 16 printed sheets of paper. Select Poster as the Multi-Page setting to print a poster-size image.
Click the Settings button to adjust the way your poster will print. The Poster Settings dialog box opens.

You can make the following settings.

<table>
<thead>
<tr>
<th>Overlapping Panels</th>
<th>Slightly overlaps the images so that they can be aligned more precisely.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Cutting Guidelines</td>
<td>Prints border lines on the images to guide you when trimming the pages.</td>
</tr>
</tbody>
</table>

If you only want to print a few of the panels without printing the entire poster, click the panels you don’t wish to print, then click OK to close the Poster Settings dialog box.

**Printing a watermark on your document**

To print a watermark on your document, click anywhere in the Watermark list box on the Layout menu to open it, and select from the list of predefined watermarks.
You can also add your own text-based or image-based watermarks to the Watermark list.

Click the Add/Del button. The following dialog box appears.

Creating an image-based watermark:

1. Select BMP.

2. Click the Browse button to specify the bitmap file you want to use, then click OK.

3. Type a name for your watermark in the Name box, then click Save.

4. Click OK to return to the Layout menu.

Creating a text-based watermark:

1. Select Text.
2. Type your text in the Text box. The text that you enter will also be assigned to the watermark as a watermark name.

3. If you want to change the watermark name, type a new name in the Name box, then click Save. Click OK to return to the Layout menu.

Making settings for your watermark:

1. Click the Settings button. The following dialog box appears.

![Watermark settings dialog box]

2. From the Watermark list box, select the watermark you want to make settings for, then make Color, Position, Density, Size, Font, Font Style and Angle settings. For details, please see the online help. Your settings are reflected in the display on the left side of the dialog box.

3. When you are finished making the settings, click OK.
**Previewing your printout**

Select the Print Preview check box on the Main menu to see a preview of your document before printing.

![Print Preview Window](image-url)
When you send a print job to the printer, the Print Preview window opens, allowing you to make changes before printing.

The Preview dialog box contains several icon buttons which you can use to perform the following functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag ‘n’ drop</td>
<td>Clicking this button lets you select and move watermarks.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Clicking this button enlarges or reduces the size of the previewed page.</td>
</tr>
<tr>
<td>Fit-to-screen</td>
<td>Clicking this button scales the previewed page so that it fits the size of the window. Select this option if you want to see the entire page at one time.</td>
</tr>
<tr>
<td>Maximum zoom</td>
<td>Clicking this button displays the previewed page at the maximum possible zoom ratio.</td>
</tr>
<tr>
<td>Printable area on/off</td>
<td>Clicking this button displays a rectangle on the page being previewed. This rectangle is the printable area for the page. The printer cannot print anything which exceeds this rectangle. Press the icon button again to turn this feature off.</td>
</tr>
</tbody>
</table>
You can also manipulate the previewed document in the following ways:

- Select and preview individual pages.
- Reduce or enlarge the size of the preview.
- Select and print any or all pages.
- Apply watermarks. The watermark you select will appear in the previewed image. For detailed information on customizing watermarks, see “Printing a watermark on your document” on page 2-20.
- Specify which pages in the document you would like printed using the Add and Remove features. To add or remove a page, you must first click the page icon in the list appearing on the left side of the preview window. Then add or remove it using the commands in the Print Options menu.
After you have previewed the document, click Print to print the document, or click Cancel to cancel printing.

**Using the Printer Utilities**

EPSON printer utilities allow you to check the current printer status and to perform some printer maintenance from your computer screen. For Windows 98, 95 and NT 4.0, utilities to check the current printer status are also available.

To use the utilities, click the Utility tab in the printer software window, then click the button for the utility you wish to use. For information on how to access the printer software, see “Accessing the printer software” on page 2-3.
Note:
- The letter in parentheses after each utility name indicates the shortcut key for that utility. Press Alt and the letter on the keyboard to open that utility.
- Do not use the Nozzle Check, Head Cleaning, and Print Head Alignment utilities with printers connected to your computer through a network.
- Do not use the Nozzle Check, Head Cleaning, and Print Head Alignment utilities while printing is in progress; otherwise, your printout may be marred.

Status Monitor 3

Status Monitor 3 provides you with printer status information, such as the amount of ink remaining, and checks for printer errors.
This utility is only available when both of the following conditions are met:
- The printer is connected directly to the host computer via the parallel port or the USB port.
- Your system is configured to support bidirectional communication.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for clogging. Check the nozzles if you notice print quality has declined and after cleaning to confirm that the print head nozzles have been cleared. If the nozzle check indicates the print head needs cleaning, you can access the Head Cleaning utility directly from the Nozzle Check utility. See “Checking the Print Head Nozzles” on page 8-2.
Head Cleaning

The Head Cleaning utility cleans the print head. You may need to clean the print head when you notice print quality has declined. Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. You can access the Nozzle Check utility directly from the Head Cleaning utility. See “Cleaning the Print Head” on page 8-4.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this utility if you notice a misalignment of vertical lines. Follow the on-screen instructions to use this utility.

Printer and Option Information

This utility allows the printer driver to confirm printer configuration information. It also provides specific information regarding certain characteristics of the printer, such as the Printer ID.
Depending on the configuration of your system, the information displayed in the Printer and Option Information dialog box may be updated automatically, or may need to be entered manually.

If a message appears in the Current Settings window prompting you to enter settings, or if you change the printer configuration, follow the steps below to make the necessary settings manually.

1. Click the Settings Sheet button in the Printer and Option Information dialog box to print out information about your printer and options. This requires that A4 or Letter size paper is loaded in your printer. You will see a printout similar to the one below.

   **Printer ID**
   50- 50- 50- 50- 50- 50

2. Make sure the settings in the utility match the information on the printed Settings Sheet. If they do not match, correct the settings on the screen to match the information on the settings sheet.

3. Click OK to exit this menu and save your settings.
**Speed & Progress**

You can make settings related to print speed and progress in this dialog box.

![Speed & Progress dialog box]

The available settings are as follows.

**High Speed Copies**

To print multiple copies of your document faster, select High Speed Copies.

**Show Progress Meter**

To monitor the progress of your print job, select Show Progress Meter.

**EPSON Printer Port (For Windows 95 and 98 only)**

To speed up the data transfer rate to EPSON printers, select EPSON Printer Port.
If your computer supports ECP mode, enable DMA transfer to speed up printing.

For more details, see “Using Speed & Progress” on page 2-36.

**Note:**
*You cannot make this setting if your printer is connected via the USB port.*

**Always Spool Raw Datatype (For Windows NT only)**

Select this check box to have Windows NT-based clients spool documents using the RAW format instead of the EMF (metafile) format (Windows NT-based applications use the EMF format by default).

Try using this option if documents spooled in EMF format do not print correctly.

Spooling RAW datatype requires less resources than EMF, so some of problems (“Insufficient Memory/Disk Space to Print”, “Slow print speed”, etc.) can be solved by selecting the “Always spool RAW datatype” check box.

When spooling RAW datatype, print progress as displayed by the Progress Meter may differ from actual print progress.

**Monitoring Preferences**

Click this button to open the Monitoring Preferences dialog box where you can make settings for EPSON Status Monitor 3. The settings are described in detail in the next section.
**Monitoring Preferences**

When you click the Monitoring Preferences button, the following dialog box appears.

![Monitoring Preferences dialog box](image)

You can make the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Notification</strong></td>
<td>Displays the current error item notification settings. Select the appropriate check boxes to specify the error types for which you wish to receive notification.</td>
</tr>
<tr>
<td><strong>Select Shortcut Icon</strong></td>
<td>Select the Shortcut Icon check box to have a shortcut icon placed in your Windows taskbar. Clicking the shortcut icon in the taskbar will open EPSON Status Monitor 3. To select which icon will be displayed, click the icon your prefer from the choices given; your selection will be shown at the right.</td>
</tr>
<tr>
<td><strong>Allow monitoring of shared printers</strong></td>
<td>Select this check box to allow monitoring of a shared printer by other computers.</td>
</tr>
</tbody>
</table>
Note:
Click the Default button to revert all Select Notification settings to their defaults.

Getting Information Through Online Help

Your printer software has an extensive online help feature, which provides you with instructions on printing, making printer driver settings, and using printer utilities.

Accessing help from your application

Open the File menu and choose Print or Print Setup. Then click Printer, Setup, Options, or Properties. (Depending on your application, you may need to click a combination of these buttons.) Click Help at the bottom of the Main, Paper, Layout, and Utility menus for help related to the items on that menu.

For Windows 95, 98, and NT 4.0, you can get specific help related to any item on a menu by right-clicking the item, then clicking the What's This? command.

Accessing help from the Windows Start menu

Click the Start button, point to Programs and Epson (for Windows 95 and 98) or EPSON Printers (for Windows NT 4.0), then click EPSON Stylus Photo 720 Help. The help contents window opens.

Increasing the Print Speed

Follow the instructions in this section to increase the printing speed of your printer.
General tips

Just as printing at a high resolution requires more processing time, printing in color takes longer than printing in black because the volume of data in a color document is much greater. For this reason, it is important to be selective in your use of color if you also require a fast print speed.

However, even if your document requires the highest resolution and extensive use of color, for example when you are printing a camera-ready composite that includes color photographs, it may still be possible to optimize the print speed by adjusting other printing conditions. Keep in mind that changing some conditions to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print speed and print quality (increasing one will decrease the other).

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Lower</th>
<th>Higher</th>
<th>Printer driver menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print speed</td>
<td>Faster</td>
<td>Slower</td>
<td></td>
</tr>
<tr>
<td>Printer driver settings</td>
<td>Print Quality</td>
<td>Economy, Normal</td>
<td>Photo</td>
</tr>
<tr>
<td>High Speed</td>
<td>On</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Halftoning</td>
<td>High Speed Halftoning</td>
<td>High Quality Halftoning</td>
<td></td>
</tr>
<tr>
<td>Finest Detail</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Data characteristics</td>
<td>Image size</td>
<td>Small</td>
<td>Large</td>
</tr>
<tr>
<td></td>
<td>Resolution</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>
The table below shows the factors related to print speed only.

<table>
<thead>
<tr>
<th>Print speed</th>
<th>Faster</th>
<th>Slower</th>
<th>Printer driver menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer driver settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ink</td>
<td>Black</td>
<td>Color</td>
<td>Advanced dialog box, Main menu</td>
</tr>
<tr>
<td>Flip Horizontal*</td>
<td>Off</td>
<td>On</td>
<td>Advanced dialog box</td>
</tr>
<tr>
<td>Collate*</td>
<td>Off</td>
<td>On</td>
<td>Paper menu</td>
</tr>
<tr>
<td>Reverse Order*</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Data characteristics</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variety of colors</td>
<td>Grayscale**</td>
<td>Full color</td>
<td>–</td>
</tr>
<tr>
<td>Hardware resources</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System speed</td>
<td>Faster</td>
<td>Slower</td>
<td>–</td>
</tr>
<tr>
<td>HDD free space</td>
<td>Large</td>
<td>Small</td>
<td></td>
</tr>
<tr>
<td>Memory free space</td>
<td>Large</td>
<td>Small</td>
<td></td>
</tr>
<tr>
<td>Software status</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Running applications</td>
<td>One</td>
<td>Many</td>
<td>–</td>
</tr>
<tr>
<td>Virtual memory</td>
<td>Not in use</td>
<td>In use</td>
<td></td>
</tr>
</tbody>
</table>

* Varies depending on the printer driver and application software you are using.

** Grayscale means using black ink only to print varying shades of gray, from pure black to pure white.
Using Speed & Progress

You can make certain print speed settings in the Speed & Progress dialog box. Click the Speed & Progress button on your printer software’s Utility menu. The following dialog box appears.

![Speed & Progress Dialog Box]

**High Speed Copies**
Select this check box to turn on high-speed printing for multiple copies. This speeds up printing by using your hard disk space as a cache when printing multiple copies of your document.

**EPSON Printer Port (For Windows 95 and 98 only)**
Select this check box to enable the EPSON printer port, which is optimized for EPSON printers, instead of the Windows default printer port. This speeds up the data transfer rate to EPSON printers.

*Note:*
*You cannot make this setting if your printer is connected via the USB port.*
Use DMA transfer (for Windows 95 and 98 only)

If your computer has a parallel port which supports ECP mode, you can enable DMA transfer to speed up printing. See your computer manual to determine if it supports ECP mode and DMA transfer.

To determine whether you need to enable DMA transfer, compare the message below the EPSON Printer Port check box to this table, and take the recommended action.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Speed (DMA) Transfer enabled.</td>
<td>DMA transfer is already enabled. Click OK to close the dialog box.</td>
</tr>
<tr>
<td>For higher data transfer rates, use DMA Transfer.</td>
<td>Follow the steps below this table to enable DMA transfer.</td>
</tr>
<tr>
<td>(No message)</td>
<td>Your system's parallel port setting does not allow DMA transfer. However, if you change the parallel port setting to ECP or Enhanced using your computer's BIOS Setup program, you may be able to use DMA transfer. Consult your computer manual or computer manufacturer for instructions. Once you change the parallel port setting, follow the steps below this table to enable DMA transfer.</td>
</tr>
</tbody>
</table>

**Note:**
Before you run the BIOS Setup program, uninstall the printer driver using Add/Remove Programs in the Control Panel. After running the BIOS Setup program, reinstall the printer driver.

If you need to enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop, then double-click Control Panel.
2. Double-click the System icon and click the Device Manager tab.
3. Double-click the Ports (COM & LPT) icon and double-click LPT1. If you have connected your printer to a port other than LPT1, double-click the appropriate port icon.

4. Click the Resources tab, then clear the Use automatic settings check box. Write down the Input/Output Range settings shown in the resource settings box.

5. Select a basic configuration setting from the Setting based on list that uses the same Input/Output Range settings as those you wrote down in Step 4, and make sure the Direct Memory Access channel and Interrupt Request numbers are allocated and displayed. Confirm also that the Conflicting device list box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether DMA transfer has been enabled.
Note:
You may not be able to use DMA transfer on some computers even after you make the settings explained above. Consult your computer maker for information on the DMA transfer capability of your computer.

Using Port Configuration (Windows NT 4.0 only)

Note:
Port settings for Windows NT 4.0 are complicated and should only be made by an experienced user with administrative privileges.

If your computer has a parallel port that supports ECP mode, you can make certain print speed settings in the Port Configuration dialog box. Before making settings, make sure that ECP mode has been selected in your computer settings. For details about ECP mode, see your computer manual.

To access the Port Configuration dialog box, click the Start button, point to Settings, and click Printers. Then select your printer and click Properties on the File menu. The printer driver opens. Click the Ports tab, then click Configure Port. The following dialog box appears.
Click the LPT port tab for the port to which your printer is connected, then click the Port Configuration button.

**Note:**
*If your printer is connected to LPT1, only the LPT1 tab is available.*

**Resources Settings (IRQ and DMA)**

If you have connected your printer to LPT2 or LPT3, making IRQ and DMA settings here may speed up printing. Input the same configuration numbers for IRQ and DMA which you have made for your expansion board. See your computer documentation to determine the settings for IRQ and DMA.

**Use DMA transfer**

Using DMA transfer to send print data to the computer may help you speed up printing. If the Use DMA Transfer check box is not available, you must first enable DMA transfer in your computer settings. For details, see your computer documentation.
Chapter 3

Checking Printer Status and Managing Print Jobs for Windows

3-Using the Progress Meter ........................................ 3-2
Using EPSON Spool Manager ..................................... 3-3
Using EPSON Status Monitor 3 ............................... 3-4
   Accessing EPSON Status Monitor 3 ......................... 3-4
   Viewing information in EPSON Status Monitor 3 ........ 3-5
Using the Progress Meter

When you send a print job to the printer, the Progress Meter opens, as shown in the illustration below.

The Progress Meter indicates the progress of the current print job and provides printer status information when bidirectional communication between the printer and computer is established. This meter also displays helpful tips for better printing and error messages, as explained below.

Note:
The Progress Meter does not appear when the Show Progress Meter setting is turned off in the Speed & Progress dialog box. See “Speed & Progress” on page 2-30 for more information.
Epson Printing Tips

Tips for getting the most out of your EPSON printer driver appear in the text box at the bottom of the Progress Meter window. A new tip appears every 30 seconds. For more details on a tip which is currently displayed, click the Details button.

Error messages

If a problem occurs during printing, an error message appears in the text box at the top of the Progress Meter window. When the ink runs low or out, a How To button appears below the text box. Click How To and EPSON Status Monitor 3 will lead you step-by-step through the cartridge replacement procedure.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If it receives two or more print jobs at one time, it holds them in the order that they were received (with printers on a network this may be called a print queue). When a print job reaches the top of the line, the EPSON Spool Manager sends the job to the printer.
Note:
EPSON Spool Manager is not available for Windows NT.

After you send a print job, an EPSON Stylus Photo 720 button appears on the taskbar. Click this button to open the EPSON Spool Manager. From the Spool Manager, you can view print status information about the print jobs which have been sent to your printer. You can also cancel, pause and resume, or restart selected print jobs.

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Paper Size</th>
<th>Status</th>
<th>Progress</th>
<th>Started At</th>
</tr>
</thead>
</table>

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the printer status.

Note:
Before using EPSON Status Monitor 3, be sure to read its README file. To open this file, click Start, point to Programs and then EPSON or EPSON Printers, then click EPSON Stylus Photo 720 Readme.

Accessing EPSON Status Monitor 3

There are two ways to access EPSON Status Monitor 3.

- Double-click the printer-shaped shortcut icon on the Windows taskbar. To add a shortcut icon to the taskbar, see “Monitoring Preferences” on page 2-32.
Open the printer driver, click the Utility tab, then click EPSON Status Monitor 3.

When you access EPSON Status Monitor 3, the following window appears.

### Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information:

- **Current Status:**
  EPSON Status Monitor 3 provides you with detailed printer status information, a graphic display, and status messages. If the ink runs low or out, the How to button appears in the EPSON Status Monitor 3 window. Clicking How to displays cartridge replacement instructions and moves the print head to the cartridge replacement position.

- **Ink Levels:**
  EPSON Status Monitor 3 provides a graphic display of the amount of ink remaining.
Chapter 4

Using the Printer Software for Macintosh

3-Printer Software Introduction .................................................. 4-2
Making Changes to Printer Settings .............................................. 4-2
  Making the Media Type setting .............................................. 4-3
  Using the Automatic mode ..................................................... 4-7
  Using the PhotoEnhance mode .............................................. 4-7
  Using the Custom mode ....................................................... 4-8
  Using the Advanced settings .............................................. 4-9
Changing the page setup .......................................................... 4-12
Setting the Print Time ............................................................ 4-15

Modifying the page layout .......................................................... 4-16
  Fitting your document to the paper size .................................. 4-17
  Printing a watermark on your document .................................. 4-17
  Printing two or four pages on one sheet ................................ 4-19
  Printing posters .................................................................. 4-20

Previewing your printout .............................................................. 4-21
  Saving print data in files ...................................................... 4-23

Using the Printer Utilities .............................................................. 4-24
  EPSON StatusMonitor ......................................................... 4-24
  Nozzle Check .................................................................. 4-25
  Head Cleaning ................................................................ 4-25
  Print Head Alignment .......................................................... 4-25
  Configuration .................................................................. 4-25
**Printer Software Introduction**

The printer software which comes with your printer includes a printer driver and printer utilities. The printer driver lets you choose from a wide variety of settings to get the best results from your printer. The printer utilities help you check the printer and keep it in top condition.

For information on using the printer driver, see “Making Changes to Printer Settings” on page 4-2.

For information on using the printer utilities, see “Using the Printer Utilities” on page 4-24.

You can also get more information about the printer software by clicking the help icon in any of the dialog boxes in the printer driver.

**Making Changes to Printer Settings**

You will find the printer driver settings in the following dialog boxes.

- Print dialog box (click **Print** on the File menu of your application or click **Options** in the Page Setup dialog box)

- Page Setup dialog box (click **Page Setup** on the File menu of your application)

- Layout dialog box (click the **Layout** icon button in the Print dialog box)

- Background Printing dialog box (click the **Background Printing** icon button located in the Print dialog box)

- Preview dialog box (click the **Preview** icon button and then click **Preview** in the Print dialog box)
The Mode settings in the Print dialog box are arranged to give you four levels of control over the printer driver, as explained below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>This mode provides the quickest and easiest way to start printing. See “Using the Automatic mode” on page 4-7.</td>
</tr>
<tr>
<td>PhotoEnhance</td>
<td>This mode lets you choose from a variety of image-correction settings specially designed for photos. See “Using the PhotoEnhance mode” on page 4-7.</td>
</tr>
<tr>
<td>Custom</td>
<td>This mode lets you choose from a list of ready-made or personalized settings suited to the kind of document you want to print. When Custom is selected, the Advanced button is enabled, allowing you to access the Advanced dialog box. See “Using the Custom mode” on page 4-8.</td>
</tr>
<tr>
<td>Advanced</td>
<td>This button opens the Advanced dialog box, where you can make detailed settings to fit your individual needs. From the Advanced dialog box, you can add your personalized settings to the Custom Settings list. See “Using the Advanced settings” on page 4-9.</td>
</tr>
</tbody>
</table>

In addition to making comprehensive Mode settings that affect overall print quality, you can also modify individual aspects of your printout using the settings contained in the Page Setup and the Layout dialog boxes. For information on page setup options, see “Changing the page setup” on page 4-12. For information on page layout options, see “Modifying the page layout” on page 4-16.

**Making the Media Type setting**

The Media Type setting determines what other settings are available, so you should always make this setting first.
In the Print dialog box, select the Media Type setting that matches the paper you loaded in the printer. To find out what Media Type you are using, find your media in the list below, and refer to the corresponding Media Type under which it is grouped (shown in larger type). For some media, there are several Media Type settings to choose from.
Plain Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

360 dpi Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059
EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper (A4) S041061
EPSON Photo Quality Ink Jet Cards (A6) S041054
EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121
EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122
EPSON Photo Quality Self Adhesive Sheets (A4) S041106
EPSON Ink Jet Note Cards A6 (with envelopes) S041147
EPSON Ink Jet Greeting Cards 5 x 8” (with envelopes) S041148
EPSON Ink Jet Greeting Cards 8 x 10” (with envelopes) S041149

Matte Paper-Heavyweight

EPSON Matte Paper-Heavyweight (A4) S041259
Photo Paper
- EPSON Photo Paper (A4) S041140
- EPSON Panoramic Photo Paper (210 × 594 mm) S041145
- EPSON Photo Paper Cards (A4) S041177

Photo Quality Glossy Film
- EPSON Photo Quality Glossy Film (A4) S041071
- EPSON Photo Quality Glossy Film (A6) S041107
- EPSON Photo Stickers 16 (A6) S041144
- EPSON Photo Stickers 4 (A6) S041176

Ink Jet Transparencies
- EPSON Ink Jet Transparencies (A4) S041063

Note:
The availability of special media varies by location.
**Using the Automatic mode**

When Automatic is selected as the Mode setting in the Print dialog box, the printer driver takes care of all detailed settings based on the current Media Type and Ink settings. To make the Ink setting, click **Color** to print in color, or **Black** to print in black-and-white or grayscale. To make the Media Type setting, see “Making the Media Type setting” on page 4-3.

![Printer Software for Macintosh](image)

*Note: Depending on the media you choose in the Media Type list (while Automatic is selected), a slider appears to the right of the Mode options that lets you choose Quality, Speed or an intermediate setting. Select Quality when print quality is more important than speed.*

**Using the PhotoEnhance mode**

The Photo Enhance mode provides a variety of image-correction settings that you can apply to your photo images before printing. PhotoEnhance does not affect your original data.
Note:
- This mode is only available when printing 32-bit color data.
- Printing with PhotoEnhance selected may increase the time required for printing, depending on your computer system and the amount of data contained in your image.

You can select from the following settings.

<table>
<thead>
<tr>
<th>Standard</th>
<th>This setting provides standard image correction for most photos. Try this first.</th>
</tr>
</thead>
<tbody>
<tr>
<td>People</td>
<td>This setting is best for photos of people.</td>
</tr>
<tr>
<td>Nature</td>
<td>This setting is best for outdoor scenery such as mountains, sky, and oceans.</td>
</tr>
<tr>
<td>Soft Focus</td>
<td>This setting makes your photos look as if they were taken with a soft-focus lens.</td>
</tr>
<tr>
<td>Sepia</td>
<td>This setting applies a sepia tone to your photos.</td>
</tr>
</tbody>
</table>

If you are printing photos taken with a digital camera, you can also select the Digital Camera Correction check box to give your printed images the smooth, natural appearance of photographs taken with a film camera.

**Using the Custom mode**

The Custom mode offers ready-made settings designed for printing text and graphs and for applying a color-matching method. You can also create and save your own custom settings. See “Using the Advanced settings” on page 4-9 for details.
You can select from the following ready-made settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text/Graph</td>
<td>This setting is good for printing presentation documents such as graphs and charts.</td>
</tr>
<tr>
<td>Economy</td>
<td>This setting is best for printing drafts of text</td>
</tr>
<tr>
<td>ColorSync</td>
<td>This setting automatically adjusts printout colors to match colors on your screen.</td>
</tr>
</tbody>
</table>

Follow the steps below to select a Custom setting.

1. Verify the Media Type and Ink settings in the Print dialog box. For details, see “Making the Media Type setting” on page 4-3.

2. Click the Custom button in the Print dialog box. This enables the Custom Settings list, located below and to the right of the Custom radio button.

3. From the Custom Settings list, select the most appropriate setting for the type of document or image you will print.

4. When you choose a Custom setting, other settings such as Print Quality, Halftoning, and Color are made automatically. Changes to these settings are reflected in the display on the left side of the Print dialog box.

**Using the Advanced settings**

The settings in the Advanced dialog box give you complete control over your printing environment. Use these settings to experiment with new printing ideas, or to fine-tune a range of print settings to meet your individual needs. Once you are satisfied with your new settings, you can give them a name and add them to the Custom Settings list.

**Making the Advanced settings**

Follow the instructions below to make Advanced settings.
1. Click the Custom button in the Print dialog box, then click the Advanced button. The Advanced dialog box appears.

2. Select the Media Type that you loaded in the printer. For details, see “Making the Media Type setting” on page 4-3.

3. Choose Color or Black as the Ink setting.

4. Select the Print Quality setting.

5. Make other settings as necessary. For details, see online help.

Note:
- The PhotoEnhance option under Color Management only affects images, not text or graphs. For example, if Monochrome is selected from the Tone list (enabled when PhotoEnhance is selected), only the images in a document will be printed in monochrome. Any colored text or graphs in the same document will be printed in color.

- Some settings may be unavailable depending on the Print Quality, Media Type, and Ink settings you make.
6. Click OK to apply your settings and return to the Print dialog box. Click Cancel to return to the Print dialog box without applying your settings. To save your Advanced settings, see the next section.

**Saving and deleting your settings**

To save your Advanced settings, click Save Settings in the Advanced dialog box. The Custom Settings dialog box appears.

![Custom Settings Dialog Box]

Type a unique name (up to 16 characters) for your settings in the Name box, then click Save. Your Advanced settings will be added to the Custom Settings list. You can save up to 10 different custom settings.

**Note:**

- You cannot apply the names of settings provided by EPSON to your custom settings.
- You cannot delete the ready-made settings from the Custom Settings list.

To delete a setting, select the setting in the Custom Settings dialog box and click Delete.

**Using your saved settings**

To select your settings, click the Custom button in the Print dialog box, then select your settings from the Custom Settings list, located below and to the right of the Custom button.
If you change the Media Type or Ink settings when one of your customized settings is selected in the Custom Settings list, the selection shown in the list returns to Custom Settings. The customized setting that was previously selected is not affected by the change. To return to your customized setting, simply reselect it in the list.

**Changing the page setup**

In the Page Setup dialog box, you can change the paper size, specify the paper orientation, reduce or enlarge your printout, and adjust the printable area.

Choose Page Setup from the File menu of your application. The Page Setup dialog box appears.

You can make the following settings in the Page Setup dialog box.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Select the paper size you want to use. If you want to define a custom paper size, see “Defining a custom paper size” on page 4-13.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Select Portrait (tall) or Landscape (wide) to change the orientation of your printout. If you need to print close to the bottom of the page, select the Rotate by 180 degrees check box.</td>
</tr>
<tr>
<td>Reduce or Enlarge</td>
<td>Use this setting to reduce or enlarge the size of your image from 25% to 400%.</td>
</tr>
</tbody>
</table>
Defining a custom paper size

If the appropriate paper size is not included in the Paper Size list in the Page Setup dialog box, follow the steps below to define a custom paper size.

1. In the Page Setup dialog box, click Customize. The following dialog box appears.
2. To define a new paper size, click **New**. The dialog box updates to allow you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size List.
4. Specify the measurement unit as either **Inches** or **cm**.
5. Enter the width and the height of your paper.
6. Specify the margins in the Margin text boxes or using the preview image.
7. Click **OK**. You return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names you create will appear in the Paper Size list in the Page Setup dialog box.

To delete a custom paper size, click **Customize** in the Page Setup dialog box, select the paper size you wish to delete from the list in the Custom Paper dialog box, and click **Delete**.

**Copying a paper size**

Follow the steps below to copy a paper size and use it as a template to create a new paper size.
1. Select the existing paper size to copy, and click Copy.

2. Specify the measurement unit as either inches or cm.

3. Set the margin in the margin input box or the preview image.

4. Click OK.

**Setting the Print Time**

You can specify the time that you want the printer to begin printing your document. Follow these steps.

1. Click the Background Printing icon button in the Print dialog box. The Background Printing dialog box opens.

![Background Printing dialog box](image)

2. Select On as the Background Printing option, if necessary.

3. Select Urgent, Normal, Print at, or Hold as the Print Time option.

   If you select Print at, use the arrows beside the date and time boxes to specify the date and time you want to print the document.

   **Note:**
   *Make sure the computer and printer will be turned on at the date and time you specify.*

4. Click OK. The Background Printing dialog box closes.
5. In the Print dialog box, make sure your print settings are as you want them, then click Print.

Note: You can check or change the priority of print jobs using the EPSON Monitor3 utility. See “Using EPSON Monitor3” on page 5-5 for details.

Modifying the page layout

You can modify the page layout of your document using the printer driver settings located in the Layout dialog box, shown below. To open this dialog box, click Print on the File menu of your application and click the Layout icon button in the Print dialog box. The Layout dialog box appears.

![Layout dialog box]

The Layout dialog box allows you to automatically match the document size to the paper size, place watermarks on documents, print two or four pages on a single sheet of paper, or print poster-size images by enlarging one page to cover several sheets.
You can also specify the printing order for your print job. When printing multiple copies of your document, select Collate to print one complete document set at a time, or Reverse Order to print your documents in reverse order, starting with the last page.

**Fitting your document to the paper size**

You can proportionally enlarge or reduce the size of the image to make it fit the paper size you select in the Paper Size list. To do this, select the Fit to Page check box, then specify the paper size you loaded in the printer in the Paper Size list.

**Printing a watermark on your document**

To print a watermark in the background of your printed documents or images, select the Watermark check box in the Page Layout dialog box.

Select the watermark you want to print from the Name list, then specify its position, size, color, and intensity. You can change the position and size of the watermark by dragging it with your mouse in the preview window at the left.
You can also add your own text-based or image-based watermarks to the Name list. Follow these steps.

1. Click the Add/Del button beside the Name list. The following dialog box appears.

![Add/Del button](image)

2. To use an image file as a watermark, click the Add PICT button. Specify the desired image file, then click Open.

![Add PICT button](image)

To create a text-based watermark, click the Add Text button. Type the text in the Text box, select a font and a text style, then click OK.
3. The image file name or the watermark text appears in the Mark Name list in the Watermark dialog box. To change the name of an image watermark, click it in the list, then type a new name. When a text watermark is selected in the Name list, you can edit the text, and change the font and text style, by clicking the Edit Text button.

4. Click OK to add your watermark to the Name list in the Page Layout dialog box.

**Printing two or four pages on one sheet**

To print two or four pages of your document on one sheet of paper, select the Multi-Page check box in the Page Layout dialog box, then click N-up.
You can make the following settings.

| **2 Pages** | Prints two or four pages of your document on a single piece of paper. |
| **4 Pages** |                                                                    |
| **Page Order** | Allows you to specify the order in which the pages will be printed on the sheet of paper. |
| **Print page frames** | Allows you to print a frame around each page on the sheet of paper. |

**Printing posters**

A single document page can be enlarged to cover 4, 9, or 16 printed sheets of paper. To print a poster-size image, select the Multi-Page check box in the Page Layout dialog box, then click Poster.

You can make the following settings.

| **1 page covers xx sheets** | Specifies how many printed sheets of paper the enlarged document page is to cover. You can select 4, 9, or 16 pages. |
| **Print Cutting Guidelines** | Prints border lines on the images to guide you when trimming the pages. |
If you only want to print a few of the panels without printing the entire poster, click Panel Selection, then click the panels you don’t wish to print, and then click OK. Only the panels that you did not click will be printed.

**Previewing your printout**

The Preview feature allows you to see how your document will look before actually printing it. Follow these steps to preview your document.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box. The Print button changes into a Preview button.

*Note:*
Use the Preview icon button to switch between the Print, Preview, and Save File modes. Click the icon to select the mode you want. For information on the Save File mode, see “Saving print data in files” on page 4-23.
3. Click the **Preview** button. The Preview dialog box appears and displays a preview of your document.

The Preview dialog box contains six icon buttons you can use to perform the following functions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Selection</th>
<th>This feature lets you select, move, and resize watermarks.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection" /></td>
<td><strong>Selection</strong></td>
<td>This feature lets you select, move, and resize watermarks.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td><strong>Zoom</strong></td>
<td>This feature enlarges the or reduces the size of the previewed page.</td>
</tr>
<tr>
<td><img src="image" alt="Margin Display/Non-Display" /></td>
<td><strong>Margin Display/Non-Display</strong></td>
<td>This feature displays or hides borderlines which indicate the printable area.</td>
</tr>
<tr>
<td><img src="image" alt="Watermark Editing" /></td>
<td><strong>Watermark Editing</strong></td>
<td>This button opens the Watermark Edit box. This dialog box allows you to add watermarks to the document, and to change any of the current watermark settings.</td>
</tr>
<tr>
<td><img src="image" alt="Add Page Remove Page" /></td>
<td><strong>Add Page Remove Page</strong></td>
<td>These buttons let you select or deselect the pages you want to print from the list on the left side of the preview window.</td>
</tr>
</tbody>
</table>
4. If you are satisfied with the previewed image, click Print. If you are not satisfied with the appearance of the image, click Cancel. The Preview and Print dialog boxes close with the current print settings preserved. Open the Print dialog box again to make additional changes to the print settings.

**Saving print data in files**

You can save print data in a file by clicking the Save File icon button in the Print dialog box. This feature lets you print the data at a later time simply by double-clicking the saved file. Follow these steps.

*Note:*
*Use the Preview icon button to switch between the Print, Preview, and Save File modes. Click the icon to select the mode you want.*

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box repeatedly until the Print button changes into the Save File button.

3. Click the Save File button. The following dialog box appears.

4. Select the location where you want to save the file, then type a file name into the Save As box and click Save.
When you want to print the data, double-click the file to open EPSON Monitor 3. Click the resume button to send the data to the printer.

**Using the Printer Utilities**

EPSON printer utilities allow you to check the current printer status and to perform some printer maintenance from your computer screen. To access the utilities, click the Utility icon button in the Print or Page Setup dialog box, then click the button for the utility you want to use.

**EPSON StatusMonitor**

The StatusMonitor utility monitors the printer status. If it detects a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining before printing.

To use the StatusMonitor, click the EPSON StatusMonitor button in the Utility dialog box. For details, see “Using EPSON StatusMonitor” on page 5-2.
Note: Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment utilities while printing is in progress; otherwise, your printout may be marred.

**Nozzle Check**

The Nozzle Check utility checks the print head nozzles for clogging. Check the nozzles if you notice print quality has declined and also after cleaning to confirm that the print head nozzles have been cleaned. If the nozzle check indicates the print head needs cleaning, you can access the Head Cleaning utility directly from the Nozzle Check utility. For details, see “Checking the Print Head Nozzles” on page 8-2.

**Head Cleaning**

This utility cleans the print head. You may need to clean the head when you notice print quality has declined. Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. For details, see “Cleaning the Print Head” on page 8-4.

**Print Head Alignment**

This utility aligns the print head. Use this utility if you notice a misalignment of vertical or horizontal lines.

**Configuration**

Clicking this button opens the Configuration dialog box, where you can change the way the StatusMonitor utility notifies you when the printer status changes. For details, see “Making Configuration Settings” on page 5-3.
Chapter 5

Checking Printer Status and Managing Print Jobs for Macintosh

5-Using EPSON StatusMonitor ............................. 5-2
   Accessing EPSON StatusMonitor ........................ 5-2
   Making Configuration Settings ......................... 5-3

Using EPSON Monitor3 .................................... 5-5
   Accessing EPSON Monitor3 .............................. 5-5
   Managing print jobs with EPSON Monitor3 ........... 5-6
   Changing the priority of print jobs .................... 5-7
Using EPSON StatusMonitor

EPSON StatusMonitor monitors the printer. If it detects a printer error, it will inform you with an error message.

You can also use this utility to check ink levels before printing. When open, EPSON StatusMonitor displays the amount of ink remaining at the time it was opened. To update the ink level information, click the Update button.

Accessing EPSON StatusMonitor

To access EPSON StatusMonitor, follow the steps below.

1. Click Print or Page Setup on the File menu of your application.

2. Click the Utility icon button in the dialog box.
3. Click the EPSON StatusMonitor button in the Utility dialog box. The following dialog box appears.

![EPSON StatusMonitor](image)

**Making Configuration Settings**

If you want to change the way the StatusMonitor utility monitors your printer, follow the steps below.

1. Click Print or Page Setup on the File menu of your application.

2. Click the Utility icon button in the dialog box.
3. Click the Configuration button. The Configuration Settings dialog box appears.

![Configuration Settings Dialog Box]

This dialog box allows you to make the following settings:

<table>
<thead>
<tr>
<th>Error notification</th>
<th>Choose how EPSON StatusMonitor notifies you in case of an error.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>Choose how EPSON StatusMonitor notifies you if a warning message becomes necessary.</td>
</tr>
<tr>
<td>Temporary Spool folder</td>
<td>Choose the folder for temporary spooling of print data.</td>
</tr>
<tr>
<td>Temporary High Speed Copies folder</td>
<td>Choose the folder for multiple-copy print data storage.</td>
</tr>
<tr>
<td>Data will be sent to the printer after being stored on your disk.</td>
<td>Select this check box to prevent horizontal banding in your printout. By default, graphics data is sent by the computer to the printer in rectangular bands, which prevents the printer from having to reconstruct an entire image in memory before printing it. Selecting this check box will make the computer temporarily store the image data on its hard drive and then send it to the printer as a whole to prevent banding in the printed image.</td>
</tr>
<tr>
<td>Check for errors before starting to print.</td>
<td>Select this check box if you want to check for errors before starting to print.</td>
</tr>
</tbody>
</table>
Using EPSON Monitor3

After you send a print job to the printer, you can use the EPSON Monitor3 utility to check, cancel, or change the priority of print jobs that are queued for printing. This utility also shows the status of the job currently being printed.

Accessing EPSON Monitor3

To access EPSON Monitor3, follow these steps.

1. First, turn on Background Printing in the Chooser or in the Background Printing dialog box.

2. Send a print job to the printer.

3. Select EPSON Monitor3 from the Application menu at the right end of the menu bar. A dialog box similar to one below opens.
Managing print jobs with EPSON Monitor3

With EPSON Monitor3, you can manage print jobs as follows:

- Use the buttons below to hold, resume, and delete print jobs for documents selected in the dialog box. First, select the appropriate print job, then click the applicable button.

<table>
<thead>
<tr>
<th></th>
<th>Hold</th>
<th>Stops printing and holds the current print job in the print queue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Resume</td>
<td>Resumes printing</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Stops printing and deletes print job from the print queue</td>
</tr>
</tbody>
</table>

- Click Stop Print Queue to stop printing. Click Start Print Queue to resume printing.

- Use the buttons below to start the printer utilities.

<table>
<thead>
<tr>
<th></th>
<th>Print head cleaning</th>
<th>Starts the Print Head Cleaning utility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Status Monitor</td>
<td>Starts the EPSON StatusMonitor, which displays the amount of ink remaining</td>
</tr>
</tbody>
</table>

- Double-click a file in the list to preview it (this function is disabled when you select the printer command file).

- Double-click Copies to change the number of copies to print out.
Click the Show details arrow to open an extension at the bottom of the EPSON Monitor3 dialog box, similar to the one below. The extended dialog box displays detailed information on the selected document’s printer driver settings.

**Changing the priority of print jobs**

To change the priority of print jobs in a print queue, follow the steps below.

*Note:*
*You can also change the priority of print jobs whose print times were previously set in the printer driver’s Background Printing dialog box.*
1. Click the Show details arrow at the bottom of the EPSON Monitor3 dialog box. You will see an extended dialog box similar to the one below.

2. Click the name of the document whose priority you wish to change in the Document Name column.

3. From the Priority list, select Urgent, Normal, Hold, or Print Time.

   Note:
   If you select Print Time, a dialog box appears where you can specify the date and time that the document will print. Make sure that your printer and computer are turned on at the time you specify.
Chapter 6

Setting Up Your Printer on a Network

6-For Windows 98 and 95 Users ................................. 6-2
  Setting up your printer as a shared printer ............... 6-2
  Accessing the printer through a network ................. 6-4

For Windows NT 4.0 Users .................................... 6-5
  Setting up your printer as a shared printer ............. 6-6
  Accessing the printer through a network ................. 6-6

For Macintosh Users ........................................... 6-10
  Setting up your printer as shared printer ............... 6-10
  Accessing the printer through a network ................. 6-12
For Windows 98 and 95 Users

This section tells you how to set up your printer so that other computers on the network can use it.

First, you need to set up the printer as a shared printer on the computer to which the printer is connected. Then, you must specify the network path to the printer from each computer that will use it, and install the printer software on those computers.

Note:
This section describes how to use your printer as a shared printer on a network. To connect your printer directly to a network without setting it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

Follow these steps to share a printer connected directly to your computer with other computers on a network.

1. Click Start, point to Settings, then click Control Panel.
2. Double-click Network.
3. Click the File and Print Sharing button.
4. Select the I want to be able to allow others to print to my printer(s) check box and click OK.
5. In the Network dialog box, click OK.

6. In the Control Panel, double-click Printers.

**Note:**
- If a dialog box requesting the Windows 98 or 95 CD-ROM appears, insert the CD-ROM in the CD-ROM drive, then follow the messages on the screen.
- If a dialog box appears requesting that you restart your computer, do so. Then open the Printers folder, and continue from step 7.

7. Select your printer in the Printers window, then click Sharing on the File menu.

8. Select Shared As and enter the printer information as necessary, then click OK.
Accessing the printer through a network

To access your printer from another computer on the network, follow these steps.

**Note:**
Your printer must be set up as a shared resource on the computer to which it is directly connected before you can access it from another computer. For instructions, see “Setting up your printer as a shared printer” on page 6-2.

1. On the computer from which you want to access the printer, click Start, point to Settings, and click Printers.
2. Double-click the Add Printer icon.
3. The Add Printer Wizard screen appears. Click Next.
4. Click Network printer, then click Next.
5. Click Browse.
6. Double-click the icon of the computer that is directly connected to the printer. Then click the printer’s icon.

7. Click OK and follow the messages on the screen.

For Windows NT 4.0 Users

This section tells you how to set up your printer so that other computers on the network can use it.

Note:
This section is written for small network users only. If you are on a large network and would like to share your printer, consult your network administrator.

First, you need to set up the printer as a shared printer on the computer to which the printer is connected. Then, you must specify the network path to the printer from each computer that will use it, and install the printer software on those computers.
Setting up your printer as a shared printer

Follow these steps to share a printer that is connected directly to your computer with others on a network.

1. Click Start, point to Settings, and click Printers.

2. Select your printer, then click Sharing on the File menu.

3. Click Shared and enter the Share Name.

4. Click OK.

Note: Do not choose any drivers from the Alternate Drivers list.

Accessing the printer through a network

To access your printer from another computer on the network, follow these steps.
**Note:**

Your printer must be set up as a shared resource on the computer to which it is directly connected before you can access it from another computer. For instructions, see “Setting up your printer as a shared printer” on page 6-6.

1. Install the printer driver to the client computer from the software CD-ROM.

2. Double-click the Printers icon in the Control Panel folder, right-click your printer’s icon, then click Properties from the list of options that appears.
3. Click the Ports tab, then click Add Port.

4. The following dialog appears. Select Local Port, then click New Port.
5. The following dialog box appears. In the text box, type: \\
name of computer that is connected to the printer\name of the shared printer

![Port Name Dialog Box]

6. Click OK.

7. In the Printer Ports dialog box, click Close to return to the Ports menu.

![Printer Ports Dialog Box]
8. On the Ports menu, make sure that the new port is added and the corresponding check box is selected. Click OK to close the printer driver.

**For Macintosh Users**

This section tells you how to set up the printer so that you can use it on an AppleTalk network. By setting up your printer as a shared printer, your local printer is connected to the network and can be used by other computers.

First, you need to setup the printer as a shared printer on the computer to which the printer is connected. Then, you must specify the network path to the printer from each computer that will use it, and install the printer software on those computers.

**Setting up your printer as shared printer**

Follow these steps to share a printer connected directly to your computer with other computers on an AppleTalk network.

1. Turn on the printer.
2. Choose Chooser from the Apple menu and click the printer's icon. Then select the port to which the printer is connected.

3. Click the Setup button. The following dialog box appears.

4. Select the Share this Printer check box, then type the printer name and password information as necessary.

5. Click OK. The name of the shared printer appears in the port list in the Chooser.

6. Close the Chooser.
Accessing the printer through a network

To access your printer from another computer on the network, follow these steps.

1. Turn on your printer.

2. On each computer from which you want to access the printer, choose Chooser from the Apple menu. Then click your printer’s icon and select the printer port you want to use from the Select a printer port list on the right. You can only select from the printers connected to your current AppleTalk zone.

3. If the following dialog box appears, enter the password for the printer, then click OK.

4. Select the appropriate Background Printing option button to turn background printing on or off.

5. Close the Chooser.
Chapter 7

Replacing Ink Cartridges

7-Replacing an Ink Cartridge.........................7-2
   Using the printer's control panel ...............7-2
   Using the Status Monitor 3.....................7-7

Replacing an Old or Damaged Ink Cartridge.........7-8
Replacing an Ink Cartridge

Follow the instructions in this section to replace an ink cartridge using the printer’s control panel or the Status Monitor utility.

Using the printer’s control panel

The printer’s indicator lights will inform you when it is time to obtain a replacement ink cartridge and when it is time to replace an empty cartridge.

This table describes the status of the lights on your printer and the actions you need to take.

<table>
<thead>
<tr>
<th>Lights</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚫💧</td>
<td>Obtain a replacement black ink cartridge.</td>
</tr>
<tr>
<td>⚫💧</td>
<td>Replace the empty black ink cartridge.</td>
</tr>
<tr>
<td>⚫💧</td>
<td>Obtain a replacement color ink cartridge.</td>
</tr>
<tr>
<td>⚫💧</td>
<td>Replace the empty color ink cartridge.</td>
</tr>
</tbody>
</table>

⚠️ = on, ⚫ = flashing

Warning:

⚠️ Keep ink cartridges out of the reach of children. Do not allow children to drink from or otherwise handle the cartridges.

⚠️ If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
Caution:

- EPSON recommends the use of genuine EPSON ink cartridges. Other products not manufactured by EPSON may cause damage to your printer not covered by EPSON’s warranties.

- Leave the old cartridge installed in the printer until you have obtained a replacement; otherwise, ink remaining in the print head nozzles may dry out.

Note:

- You cannot continue printing with one ink cartridge empty, even if the other cartridge still contains ink. Before printing, replace the empty cartridge.

- In addition to the ink used during document printing, ink is consumed during the print head cleaning operation and during the self-cleaning cycle which is performed when the printer is turned on, and during ink charging when the ink cartridge is installed in the printer.

For more information about ink cartridges, see “When handling the ink cartridges” on page -6.

To replace an ink cartridge using the cleaning button, follow the steps below.

1. Make sure the printer is on. The power light should be on, but not flashing. (Determine which cartridge needs to be replaced as indicated by the black and color ink out lights.)

2. Lower the output tray at the front of the printer, then open the printer cover.
3. Hold down the ⬇️ ⬇️ cleaning button for three seconds. The print head moves left to the ink cartridge replacement position, and the ⚪ power light begins flashing.

![Image of printer with cleaning button highlighted]

**Caution:**

*Do not move the print head by hand as this may damage the printer. Always press the ⬇️ ⬇️ cleaning button to move it.*

4. Push back the release tabs and lift up the clamp that holds the cartridge you want to replace as far as it will go. The cartridge rises partly out of the cartridge holder.

![Image of hand lifting up cartridge clamp]

The illustration shows color ink cartridge replacement. To replace the black ink cartridge, lift up only the smaller clamp on the left.
5. Lift the cartridge out of the printer and dispose of it properly. Do not take the used cartridge apart or try to refill it.

6. Remove the new ink cartridge from its protective bag. Next, remove only the yellow tape seal from the cartridge.
Caution:

- You must remove the yellow tape seal from the cartridge before installing it; otherwise, the cartridge will become unusable and you will be unable to print.

- If you have installed an ink cartridge without removing the yellow tape seal, you must remove the cartridge and install a new one. Prepare the new cartridge by removing the yellow tape seal, then install it in the printer.

- Do not remove the blue portion of the tape seal from the top of the cartridge; otherwise, the print head may become clogged and unable to print.

7. Place the ink cartridge gently into the cartridge holder with the label on the cartridge facing up. Do not press down on the cartridge.

8. Lower the ink cartridge clamp until it locks into place.

The illustration shows color ink cartridge replacement. To replace the black ink cartridge, replace only the cartridge held by the smaller clamp on the left.
Caution:
After you remove an ink cartridge from the printer, please insert a new one immediately. If no cartridge is present, the print head may dry out and become unable to print.

9. Press the \textbullet\textcircled{C} cleaning button. The printer moves the print head and begins charging the ink delivery system. This process takes about one minute to complete. When the ink charging process is finished, the printer returns the print head to its home position, the \textbullet\textcircled{C} power light stops flashing and stays on, and the black and \textbullet\textcircled{C} color lights come on.

Caution:
The \textbullet\textcircled{C} power light continues to flash while the printer performs the ink charging operation. Never turn off the printer while this light is flashing. Doing so can result in incomplete charging of ink.

10. Close the printer cover.

Using the Status Monitor 3

You can monitor the remaining ink levels from your computer and view on-screen instructions for replacing a low or empty ink cartridge using the EPSON Status Monitor 3 utility.
When an ink cartridge is low or empty, click the **How To** button in the EPSON Status Monitor 3 window. The print head moves to the ink cartridge replacement position. Follow the on-screen instructions to replace the cartridge.

For more information on using EPSON Status Monitor 3, see “Using EPSON Status Monitor 3” on page 3-4.

---

**Replacing an Old or Damaged Ink Cartridge**

In some circumstances you may need to replace an ink cartridge before it is empty. For example, if the quality of your printouts remains poor even after repeatedly cleaning and aligning the print head, one or both of the ink cartridges may be old or damaged and should be replaced.

To replace an ink cartridge before the black or color ink out light flashes, follow these steps.

If the black or color ink out light is flashing or is on, replace the empty ink cartridge as described in “Replacing an Ink Cartridge” on page 7-2.

**Caution:**
- Once you remove an ink cartridge, it becomes unusable and cannot be reinstalled even if ink remains.
- Leave the old cartridge installed in the printer until you are ready to replace it with a new one.

1. Make sure the printer is on. The power light should be on, but not flashing.

2. Lower the output tray; then open the printer cover.
3. Hold down the load/eject button for three seconds; the print head moves to the replacement position. The power light begins flashing.

4. Lift the appropriate ink cartridge clamp. Then lift the ink cartridge out of the printer and dispose of it properly.

5. Remove the yellow tape seal from the new cartridge.

6. Place the cartridge gently into the cartridge holder. Do not press down on the cartridge. Then lower the ink cartridge clamp until it locks into place.

Caution:
Once you install the cartridges, do not open their clamps again until you replace the ink cartridges. Otherwise, the cartridges may become unusable.
7. Press the \( \text{load/eject} \) button again. The printer moves the print head back to its home position and charges ink in the system.

\[ \text{Caution:} \]
*The \( \bigcirc \) power light continues to flash while the printer performs the ink charging operation. Never turn off the printer while the \( \bigcirc \) power light is flashing. Doing so can result in incomplete charging of ink.*
Chapter 8

Maintenance

8-Checking the Print Head Nozzles ....................... 8-2
   Using the Nozzle Check utility ....................... 8-2
   Using the control panel buttons ....................... 8-3

Cleaning the Print Head ................................ 8-4
   Using the Head Cleaning utility ....................... 8-5
   Using the control panel buttons ....................... 8-8

Aligning the Print Head .................................... 8-9

Cleaning the Printer ........................................ 8-10

Transporting the Printer ..................................... 8-11

Updating Software ............................................. 8-12
   Updating to Windows 98 ................................. 8-13
   Updating the driver in Windows NT 4.0 ............... 8-13
Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in the printed image are missing, you may be able to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer using the Nozzle Check utility in the printer software, or from the printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility

Follow the steps below to use the Nozzle Check utility.

*Note:*
Do not use the Nozzle Check utility while printing is in progress; otherwise, your printout may be marred.

For Windows users
1. Make sure A4 or Letter size paper is loaded in the sheet feeder.
2. Access the printer software. If you need instructions, see “Accessing the printer software” on page 2-3.
3. Click the Utility tab, then click the Nozzle Check button.
4. Follow the instructions on your screen.

For Macintosh users
1. Make sure A4 or Letter size paper is loaded in the sheet feeder.
2. Access the Print or Page Setup dialog box.
3. Click the Utility icon button, then click the Nozzle Check button.
4. Follow the instructions on your screen.
Using the control panel buttons

Follow the steps below to check the print head nozzles using the control panel buttons.

1. Turn off your printer.

2. Make sure that A4 or Letter size paper is loaded in the sheet feeder.

3. Hold down the load/eject button (① in the illustration below) and press the power button (② in the illustration below) to turn on the printer.

4. Then release both buttons.
The printer prints an operation check page including your printer’s ROM version information, the ink counter code, and a nozzle check pattern. Below are sample printouts.

Good sample

![Good sample printout]

Print head needs to be cleaned

![Print head needs to be cleaned]

The above sample is in black and white, but the actual test prints in color (CMYK).

If the nozzle check page does not print satisfactorily (for example, if any segment of the printed lines is missing) there is a problem with the printer. This could be a clogged ink nozzle or a misaligned print head. See the next section for details on cleaning the print head. For information on aligning the print head, see “Aligning the Print Head” on page 8-9.

**Cleaning the Print Head**

If you find that the printed image is unexpectedly faint or dots in the printed image are missing, you may be able to solve these problems by cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer with the Head Cleaning utility in the printer software, or from the printer itself by using the printer’s control panel buttons.
Note:

- Print head cleaning uses both color and black ink. To avoid wasting ink, clean the print head only if print quality declines; for example, if the printout is blurry or the color is incorrect or missing.

- Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.

- When the ♦ black or ♣ color ink out light is flashing or on, you cannot clean the print head. Replace the appropriate ink cartridge first.

- Do not start the Head Cleaning or Nozzle Check utility while printing is in progress; otherwise, your printout may be marred.

**Using the Head Cleaning utility**

Follow the steps below to use the Head Cleaning utility.

*For Windows users*

1. Make sure that the printer is on and both ♦ black and ♣ color ink out lights are off.

   **Note:**
   *If the ♦ black or ♣ color ink out light is flashing, you cannot clean the print head. Replace the appropriate ink cartridge first.*

2. Access the printer software. If you need instructions, see “Accessing the printer software” on page 2-3.

3. Click the Utility tab, then click the Head Cleaning button.

4. Follow the messages on your screen.

   The ♦ power light flashes while the printer performs the cleaning cycle. It takes about thirty seconds to complete.
Caution:
Never turn off the printer while the power light is flashing. Doing so may damage the printer.

5. When the power light stops flashing, click Print nozzle check pattern in the Head Cleaning dialog box to confirm that the head is clean and to reset the cleaning cycle.

Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints in color.

In the check pattern, if you find that any segments are missing from the test lines, you may need to repeat the head cleaning and print the nozzle check pattern again.

If print quality hasn’t improved after repeating this procedure four or five times, turn the printer off and leave it alone overnight. Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge, see “Replacing an Ink Cartridge” on page 7-2.
If print quality remains a problem after replacing the ink cartridges, contact your dealer.

**Note:**
*To maintain print quality, we recommend turning on the printer for at least one minute every month.*

For **Macintosh users**

1. Make sure that the printer is on, and the ♦ black and ○ color ink out lights are off.

2. Click the Utility icon button in the Print or Page Setup dialog box, then click the **Head Cleaning** button.

3. Follow the on-screen instructions.

   The ○ power light flashes while the printer performs the cleaning cycle. This operation takes about thirty seconds to complete.

   **Caution:**
   *Never turn off the printer while ○ power light is flashing. Doing so may damage the printer.*

4. When the ○ power light stops flashing, click the **Confirmation** button in the Head Cleaning dialog box to print a nozzle check pattern and to reset the cleaning cycle. Use the check pattern to confirm the head is clean. See page 148 to see a sample of the nozzle check pattern.

If print quality hasn’t improved after repeating this procedure four or five times, turn the printer off and leave it alone overnight. Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge, see “Replacing an Ink Cartridge” on page 7-2.
If print quality remains a problem after replacing the ink cartridges, contact your dealer.

**Note:**
*To maintain print quality, we recommend turning on the printer for at least one minute every month.*

**Using the control panel buttons**

Follow the steps below to clean the print head using the control panel buttons.

1. Make sure that the ⚪ power light is on and that both the ● black and ○ color ink out lights are off.

   **Note:**
   *If the ● black or ○ color ink out light is flashing or on, you cannot clean the head.*

2. Hold down the ● cleaning button for three seconds.

   ![Control panel](image)

   The printer starts cleaning the print head and the ⚪ power light begins flashing. Print head cleaning takes about thirty seconds to complete.

   **Caution:**
   *Never turn off the printer while the ⚪ power light is flashing. Doing so may damage the printer.*
3. When the ⏰ power light stops flashing, print a nozzle check pattern to confirm that the head is clean and to reset the cleaning cycle.

If print quality hasn’t improved after repeating this procedure four or five times, turn the printer off and leave it alone overnight. Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge before it is empty, see “Replacing an Ink Cartridge” on page 7-2.

If print quality remains a problem after replacing the ink cartridges, contact your dealer.

*Note:*
To maintain print quality, we recommend turning on the printer for at least one minute every month.

---

**Aligning the Print Head**

If you notice a misalignment of vertical lines, you may be able to solve this problem from your computer using the Print Head Alignment utility in your printer software. Follow the directions below.

*Note:*
Do not start the Print Head Alignment utility while printing is in progress; otherwise, your printout may be marred.

**For Windows users**

1. Make sure A4 or Letter size plain paper is loaded in the sheet feeder.

2. Access the printer software. If you need instructions, see “Accessing the printer software” on page 2-3.
3. Click the Utility tab, then click the Print Head Alignment button.

4. Follow the messages on your screen to align the print head.

For Macintosh users

1. Make sure A4 or Letter size plain paper is loaded in the sheet feeder.

2. Click the Utility icon button in the Printer Page Setup dialog box, then click the Print Head Alignment button.

3. Follow the messages on your screen to align the print head.

Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly several times a year as follows.

1. Make sure the printer is turned off and all the printer’s lights are off. Then unplug the power cord.

2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt from the sheet feeder.

4. If the outer case or the inside of the sheet feeder is dirty, clean it with a soft, clean cloth dampened with mild detergent. Keep the printer cover closed to prevent water getting inside.

5. If the inside of the printer accidentally gets soiled with ink, wipe it off with a damp cloth.

Warning: Be careful not to touch the gears inside the printer.
**Caution:**

- Never use alcohols or thinners to clean the printer; these chemicals can damage the components as well as the case.
- Be careful not to get water on the printer mechanism or electronic components.
- Do not use a hard or abrasive brush.
- Do not spray the inside of the printer with lubricants; unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is needed.

---

**Transporting the Printer**

If you need to transport your printer, carefully prepare and repack it as described below using the original box (or similar box that the printer fits) and packing materials.

1. Open the printer cover and make sure that the print head is in the home (far right) position. If not, turn the printer on and wait until the print head returns to the home position. Then turn the printer off and close the printer cover.

**Caution:**

*Leave the ink cartridges installed when you transport the printer. Removing the cartridges during transport can damage the printer.*

2. Unplug the power cord from the electrical outlet, then disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder and remove the paper support.
4. Open the printer cover again. Secure the ink cartridge holder to the printer with tape as shown below, then close the printer cover.

5. Push in the output extension tray, and then raise the output tray.

6. Attach the protective materials to both sides of the printer.

7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

**Updating Software**

Follow the directions in this section if you have upgraded your computer from Windows 95 to Windows 98 or if you are a Windows NT 4.0 user and wish to update your printer driver from a previous version.
Updating to Windows 98

If you have upgraded your computer’s operating system from Windows 95 to Windows 98, you must uninstall your printer software and then install it again. Uninstall the printer software by double-clicking the Add/Remove Programs icon in the Windows Control Panel and selecting EPSON Printer Software from the list. Click the Add/Remove button and then Yes in the dialog box that appears. Click OK in the Add/Remove Programs Properties dialog box and install the printer software again.

Updating the driver in Windows NT 4.0

When you update the printer driver in Windows NT 4.0, please be sure to uninstall the previous printer driver before you install the new driver. Installing over the existing printer driver results in a failure to update. To uninstall the printer driver, double-click the Add/Remove Programs icon in the Windows Control Panel. The Add/Remove Programs properties dialog box appears. Select EPSON Printer Software from the list, click Add/Remove, and then OK. Then, install the printer software again.
Chapter 9

Troubleshooting

9-Diagnosing the Problem ............................................. 9-3
  Error indicators .................................................. 9-4
  Status Monitor 3 ............................................... 9-5
  Running a printer operation check ......................... 9-5

Cancelling Printing .................................................. 9-8
  For Windows 98, 95 and NT 4.0 ....................... 9-9
  For Macintosh ................................................. 9-9

Print Quality Could Be Better ................................. 9-10
  Horizontal banding ........................................ 9-10
  Vertical misalignment or banding ..................... 9-11
  Color gaps .................................................... 9-12
  Incorrect or missing colors ............................. 9-12
  Blurry or smeared printout ............................. 9-13

Printouts Are Not What You Expected ..................... 9-14
  Incorrect or garbled characters ....................... 9-14
  Incorrect margins ......................................... 9-15
  Inverted image .............................................. 9-15
  Blank pages print ......................................... 9-16
  Printout has smears on the bottom edge. ............. 9-16
  Printing is too slow ...................................... 9-16

Printer Doesn't Print ........................................... 9-17
  All lights are off .......................................... 9-17
  Lights came on and then went out.................... 9-18
  Only the power light is on ............................. 9-18
  Paper out light is flashing or on ..................... 9-19
  One of the ink out lights is flashing or on .......... 9-19
  Ink out lights are on and the other lights are flashing 9-19

Paper Doesn't Feed Correctly ................................... 9-20
  Paper doesn’t feed ....................................... 9-20
  Multiple pages feed ..................................... 9-21
  The paper jams ............................................. 9-21
Paper isn't ejected fully or is wrinkled ............... 9-22
Where to Get Help ........................................ 9-22
Diagnosing the Problem

Troubleshooting printer problems is best handled in two easy steps: first diagnose the problem, then apply likely solutions until the problem is fixed. The information that you need to diagnose the most common problems is provided by the printer’s control panel lights and by the Status Monitor utility.

Use the information presented in this chapter to pinpoint the source of your problem, then apply the recommended solutions until the problem is solved.
Error indicators

You can identify many common printer problems using the lights on your printer’s control panel. If your printer stops working and the lights are on or flashing, use the following table of panel light patterns to diagnose the problem, then follow the recommended corrective measures.

<table>
<thead>
<tr>
<th>Lights</th>
<th>Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![light] ![light]</td>
<td><strong>Paper out</strong></td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>No paper is loaded in the printer.</td>
</tr>
<tr>
<td>![light] ![light] ![light] ![light]</td>
<td>Load paper in the sheet feeder, then press the load/eject button. The printer resumes printing and the light goes out.</td>
</tr>
<tr>
<td>![light] ![light] ![light] ![light]</td>
<td><strong>Paper jam</strong></td>
</tr>
<tr>
<td>![light] ![light] ![light] ![light]</td>
<td>Paper has jammed in the printer.</td>
</tr>
<tr>
<td>![light] ![light] ![light] ![light] ![light]</td>
<td>Press the load/eject button. The printer ejects the jammed paper and then resumes printing. If the error is not cleared, open the printer cover and remove the jammed paper. Then reload paper in the sheet feeder and press the load/eject button. The printer resumes printing.</td>
</tr>
<tr>
<td>![light] ![light]</td>
<td><strong>Ink low (black ink cartridge)</strong></td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>The black ink cartridge is nearly empty.</td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>Obtain a replacement black ink cartridge.</td>
</tr>
<tr>
<td>![light] ![light]</td>
<td><strong>Ink out (black ink cartridge)</strong></td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>The black ink cartridge is empty or not installed.</td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>Replace the black ink cartridge with a new one. See “Replacing an Ink Cartridge” on page 7-2 for details.</td>
</tr>
<tr>
<td>![light] ![light]</td>
<td><strong>Ink low (color ink cartridge)</strong></td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>The color ink cartridge is nearly empty.</td>
</tr>
<tr>
<td>![light] ![light]</td>
<td>Obtain a replacement color ink cartridge.</td>
</tr>
</tbody>
</table>
Status Monitor 3

The Status Monitor 3 utility provides status messages and a graphic display showing the current status of the printer.

If a problem occurs while printing, an error message is displayed in the Progress Meter window.

When ink is out, click the How To button in the Status Monitor or Progress Meter window and EPSON Status Monitor 3 will lead you step-by-step through the cartridge replacement procedure.

Running a printer operation check

Performing a printer operation check can help you determine whether the problem comes from the printer or the computer.

### Troubleshooting

<table>
<thead>
<tr>
<th>Status Monitor 3</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink out (color ink cartridge)</td>
<td>The color ink cartridge is empty or not installed.</td>
<td>Replace the color ink cartridge with a new one. See “Replacing an Ink Cartridge” on page 7-2 for details.</td>
</tr>
<tr>
<td>Carriage error</td>
<td>The print head carriage is obstructed by jammed paper or other foreign material and cannot return to the home position.</td>
<td>Turn off the printer. Open the printer cover and remove any paper from the paper path by hand. Then turn the printer back on. If the error is not cleared, contact your dealer.</td>
</tr>
<tr>
<td>Unknown printer error</td>
<td>An unknown printer error has occurred.</td>
<td>Turn off the printer, and contact your dealer.</td>
</tr>
</tbody>
</table>

■ = on, □ = off, □ = flashing
To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.
   
   If you use the parallel interface, unlock the wire clips on both sides of the interface connector and remove the ground connector, if necessary. Then disconnect the cable from the printer’s interface connector.

3. Make sure that A4 or Letter size paper is loaded in the sheet feeder.
4. Hold down the load/eject button and press the power button to turn on the printer. Then release both buttons.

The printer prints an operation check page including the version of your printer’s ROM, the ink counter code, and a nozzle check pattern.

Compare the quality of the printed check page with the sample shown below. If there are no print quality problems, such as gaps or missing segments in the test lines, the printer itself is all right and the problem probably lies in the printer software settings, application settings, the interface cable (be sure to use a shielded cable), or the computer itself.

The above sample is in black and white, but the actual check page prints in color (CMYK).
If the check page does not print satisfactorily as shown below, there is a problem with the printer. For example, if any segment of the printed lines is missing, this could be a clogged ink nozzle or a misaligned print head.

The above sample is in black and white, but the actual check pattern prints in color.

**Cancelling Printing**

If the printouts are not what you expected and display incorrect or garbled characters or images, you may need to cancel printing. To cancel printing, follow the instructions below.
For Windows 98, 95 and NT 4.0

When you send a print job to the printer, the Progress Meter appears on your computer screen.

Click the Stop button to cancel printing.

For Macintosh

The procedure for canceling printing for Macintosh varies, depending upon whether background printing is on or off.

When background printing is on

1. Select EPSON Monitor3 from the application menu.
2. Click the name of the document which is printing in the Document Name list, then click the Stop icon button to cancel the print job.

3. Press the power button to turn off the printer.

![Printer Interface](image)

When background printing is off

1. Hold down the command key on your keyboard and press the period (.) key to cancel the print job.

2. Press the power button to turn off the printer.

Print Quality Could Be Better

If you are having print quality problems, try the solutions offered in this section.

Horizontal banding

Try one or more of these solutions:

- Make sure the printable side of the paper is face up in the sheet feeder.
Run the Head Cleaning utility to clear any clogged ink nozzles.

Select the Automatic as the Mode setting on your printer driver’s Main menu (Windows) or in the Print dialog box (Macintosh).

Check the black and color ink out lights. If a light is flashing, replace the ink cartridge. See “Replacing an Ink Cartridge” on page 7-2.

Make sure that Maximum is not selected as the Printable Area setting in your printer driver. When this setting is selected, banding may occur in the expanded area.

Make sure the Media Type selected in the printer driver is appropriate for the type of media loaded in the printer.

Vertical misalignment or banding

Try one or more of these solutions:

Make sure the printable side of the paper is face up in the sheet feeder.

Run the Print Head Alignment utility.

Clear the High Speed check box in your printer driver. For instructions, see “Using the Advanced settings” on page 2-12 for Windows. For Macintosh, see “Using the Advanced settings” on page 4-9.

Run the Head Cleaning utility to clear any clogged ink nozzles.

Make sure the Media Type setting selected in the printer driver is right for the type of media loaded in the printer.
**Color gaps**

Try one or more of these solutions:

- Make sure your paper is not damaged, dirty, or too old. Also, make sure the printable side of the paper is face up in the sheet feeder.

- Run the Head Cleaning utility to clear any clogged ink nozzles.

- Check the black and color ink out lights. If one of the lights is flashing, replace the appropriate ink cartridge. See “Replacing an Ink Cartridge” on page 7-2.

- Adjust the color settings in your application software or your printer driver. For instructions, see “Using the Advanced settings” on page 2-12 for Windows or “Using the Advanced settings” on page 4-9 for Macintosh.

- Select Automatic as the Mode setting on your printer driver’s Main menu (Windows) or in the Print dialog box (Macintosh).

- Make sure the Media Type setting selected in the printer driver is appropriate for the type of media loaded in the printer.

**Incorrect or missing colors**

Try one or more of these solutions:

- Change the Ink setting in your printer driver to Color. For instructions, see “Using the Automatic mode” on page 2-8 for Windows or “Using the Automatic mode” on page 4-7 for Macintosh.

- Adjust the color settings in your application software or your printer driver. For instructions, see “Using the Advanced settings” on page 2-12 for Windows or “Using the Advanced settings” on page 4-9 for Macintosh.
Run the Head Cleaning utility. If colors are still incorrect or missing, replace the color ink cartridge. If the problem persists, replace the black ink cartridge. See “Replacing an Ink Cartridge” on page 7-2.

**Blurry or smeared printout**

Try one or more of these solutions:

- Make sure your paper is dry and the printable side is facing up. Also, make sure you’re using an acceptable paper type. See “Paper” on page B-2 for specifications.
- Select Automatic as the Mode setting on your printer driver’s Main menu (Windows) or in the Print dialog box (Macintosh).
- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.
- Set the adjust lever to the “+” position, and make sure the Media Type setting in your printer driver is correct.
- Remove each sheet from the output tray as it is printed, especially if you are using transparencies.
- If you’re printing on glossy media or transparencies, place a support sheet (or a sheet of plain paper) beneath the stack. Or, load one sheet at a time.
- Run the Head Cleaning utility.
- Run the Print Head Alignment utility.
Ink may have leaked inside the printer; wipe the inside of the printer with a soft, clean cloth.

Warning: Be careful not to touch the gears inside the printer.

**Printouts Are Not What You Expected**

If one of the following problems has occurred, try the solutions listed for the problem.

- Incorrect or garbled characters
- Incorrect margins
- Inverted image
- Blank pages print
- Printout has smears on the bottom edge
- Printing is too slow

**Incorrect or garbled characters**

Try one or more of these solutions:
Select your printer as the default printer in Windows.

Clear any stalled print jobs from the Spool Manager. For instructions, see “Using EPSON Spool Manager” on page 3-3.

Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged in.

If you are using Windows NT 4.0, try to uninstall the EPSON Printer Port. Click Start, point to Programs, then point to EPSON Printers and click EPSON Printer Port Uninstall. Follow the instructions on the screen.

**Incorrect margins**

Try one or more of these solutions:

- Check the margin settings in your application software. Make sure the margins are within the printable area of the page. See “Paper” on page B-2 for specifications.

For Windows, check the settings in the Paper menu. Make sure the settings are appropriate for the paper size you are using.

For Macintosh, check the settings in the Page Setup dialog box. Make sure the settings are appropriate for the paper size you are using.

**Inverted image**

Turn off the Flip Horizontal setting in the printer driver, or the “Mirror” setting in your application software. For instructions, see the online help for the printer driver or for your application.

For Macintosh, see also “Using the Advanced settings” on page 4-9.
Blank pages print

Try one or more of these solutions:

- Select your printer as the default printer in Windows.
- For Windows, check the settings in the Paper dialog box. Make sure they are appropriate for the paper size you are using.
  
  For Macintosh, check the settings in the Page Setup dialog box. Make sure they are appropriate for the paper size you are using.
- Run the Head Cleaning utility to clear any clogged nozzles.

After trying one or more of these solutions, run a printer operation check to check your results. See “Running a printer operation check” on page 9-5 for details.

Printout has smears on the bottom edge

Try one or more of these solutions:

- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.
- Set the adjust lever to the “+” position, and clear the High Speed check box in your printer driver’s Advanced dialog box. The Advanced dialog box is accessible through the Main menu (for Windows) or Print dialog box (for Macintosh) when Custom is selected as the Mode setting. To turn this option off, you may also need to change the Print Quality setting.

Printing is too slow

Try one or more of these solutions:
Make sure the Media Type setting in your printer driver is correct. For instructions, see “Making the Media Type setting” on page 2-5 for Windows or “Making the Media Type setting” on page 4-3 for Macintosh.

Select Automatic as the Mode setting on your printer driver’s Main menu (Windows) or in the Print dialog box (Macintosh) and then move the slider to Speed. For instructions, see “Using the Automatic mode” on page 2-8 for Windows or “Using the Automatic mode” on page 4-7 for Macintosh.

Close any applications you are not using at the moment.

If you upgraded from Windows 95 to Windows 98, uninstall the printer software using Add/Remove Programs in the Control Panel in Windows, then install the software again.

---

**Printer Doesn’t Print**

If one of the following error indications is displayed, try the solutions listed.

- All lights are off
- Lights came on and then went out
- Only the power light is on
- The paper out light is flashing or on
- One of the ink out lights is flashing or on
- Ink out lights are on and the other lights are flashing

**All lights are off**

Try one or more of these solutions:
Press the \( \bigcirc \) power button and make sure the printer is on.

Turn off the printer and make sure the power cord is securely plugged in.

Make sure your outlet works and is not controlled by a wall switch or timer.

**Lights came on and then went out**

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it immediately. Then, check the printer labels.

If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact your dealer.

**Only the power light is on**

Try one or more of these solutions:

Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged in.

Make sure there is no packing material in the printer.

Turn off the printer and computer and disconnect the printer’s interface cable. Then print an operation check page. See “Running a printer operation check” on page 9-5.

If the check page prints, make sure the printer software and your application software are installed correctly.

If you’re trying to print a large image, your computer may not have enough memory to print. Try printing a smaller image.

If you are using Windows NT 4.0, try to uninstall the EPSON Printer Port. Click Start, point to Programs and EPSON Printers, then click EPSON Printer Port Uninstall. Follow the messages on the screen.
Clear any stalled print jobs from the Spool Manager. For instructions, see “Using EPSON Spool Manager” on page 3-3.

If the printer sounds like it’s trying to print, but is unable to, run the Head Cleaning utility. If this doesn’t work, replace the ink cartridges. See “Replacing an Ink Cartridge” on page 7-2 for instructions.

**Paper out light is flashing or on**

If the paper out light is flashing, remove any paper that may be jammed in the printer.

If the paper out light is on, load more paper in the sheet feeder.

**One of the ink out lights is flashing or on**

If the black or color ink out light is flashing, ink is low. Prepare a replacement cartridge.

If the black or color light is on, ink is out. Replace the appropriate cartridge. See “Replacing an Ink Cartridge” on page 7-2.

**Ink out lights are on and the other lights are flashing**

Follow the steps below.

1. Press the load/eject button, then remove any paper in the printer.

2. Turn the printer off. Check for and remove any foreign objects or pieces of paper from inside the printer. Also, make sure that there is sufficient space around the vent on the back of the printer to allow proper ventilation. Remove any objects blocking the vent. Then, turn the printer back on.
Note:
If you cannot remove the foreign object by yourself, do not use force and do not disassemble the printer. Call your dealer for assistance.

3. If the error is not cleared, contact your dealer.

---

**Paper Doesn't Feed Correctly**

If one of the following problems has occurred, try the solution(s) listed for the problem.

- Paper doesn't feed
- Multiple pages feed
- The paper jams
- Paper isn’t ejected fully or is wrinkled

**Paper doesn't feed**

Remove the stack of paper and make sure of the following:

- The paper isn’t curled or creased.
- The paper isn’t too old. See the instructions that came with the paper for more information.
- The paper isn’t loaded above the arrow on the left edge guide.
- The paper isn’t jammed inside. If it is, remove the jammed paper.
- Black and/or color ink are out. Replace the appropriate cartridge. See “Replacing an Ink Cartridge” on page 7-2.
Then, load the paper again. Make sure you follow any special loading instructions that came with your paper. See also “Paper Handling” on page 19.

**Multiple pages feed**

Remove the stack of paper and make sure the paper is not too thin. See “Paper” on page B-2 for specifications. Fan the edges of the stack to separate the sheets, then reload the paper.

If too many copies of a document are being printed, check the Copies setting in both the printer driver and your application. For instructions, see “Modifying the printout style” on page 2-15 for Windows or “Modifying the page layout” on page 4-16 for Macintosh.

**The paper jams**

Press the load/eject button to eject the jammed paper. If the error message does not clear, open the cover and remove all the paper inside, including any torn pieces. Then load the paper again.

_How _

If you cannot remove the foreign object by yourself, do not use force and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

- The paper is smooth, not curled or wrinkled.
- The paper is of high-quality, loaded with the printable side up.
- The paper stack was fanned before loading.
- The paper isn’t loaded above the arrow on the left edge guide.
- The left edge guide is adjusted to fit your paper.
**Paper isn't ejected fully or is wrinkled**

If the paper doesn’t eject fully, press the load/eject button. Also check the Paper Size setting in your application or printer driver.

If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack.

*Note:*
*Store any unused paper in its original packaging in a dry area. See “Paper” on page B-2 for specifications.*

---

**Where to Get Help**

If your printer is not operating properly and you cannot solve the problem using the troubleshooting information in your printer documentation, contact customer support services for assistance.

Customer support will be able to help you much more quickly if you give them the following information.

- Serial number of your printer  
  (The serial number label is on the back of the printer)

- Printer model

- Brand and model of your computer

- Printer software version  
  (Click *About* in your printer driver)

- Windows version you are using

- Software application(s) you normally use with your printer and their version number(s)
Consumable Products

The following ink cartridges and EPSON special media are available for your printer.

Ink cartridges

You can use the following cartridges with your printer.

<table>
<thead>
<tr>
<th>Ink Cartridge</th>
<th>Product Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black ink cartridge</td>
<td>S020187</td>
</tr>
<tr>
<td>Color ink cartridge</td>
<td>S020193</td>
</tr>
</tbody>
</table>

Note:
The product numbers of ink cartridges may vary by location.

EPSON special media

EPSON offers specifically designed media for ink jet printers to meet most high-quality printing needs.

<table>
<thead>
<tr>
<th>Media</th>
<th>Product Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Premium Ink Jet Plain Paper (A4)</td>
<td>S041214</td>
</tr>
<tr>
<td>EPSON 360 dpi Ink Jet Paper (A4)</td>
<td>S041059</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper (A4)</td>
<td>S041061</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards (A6)</td>
<td>S041054</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards (5 × 8”)</td>
<td>S041121</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards (8 × 10”)</td>
<td>S041122</td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets (A4)</td>
<td>S041106</td>
</tr>
<tr>
<td>EPSON Ink Jet Note Cards A6 (with envelopes)</td>
<td>S041147</td>
</tr>
<tr>
<td>EPSON Ink Jet Greeting Cards 5 × 8” (with envelopes)</td>
<td>S041148</td>
</tr>
<tr>
<td>EPSON Ink Jet Greeting Cards 8 × 10” (with envelopes)</td>
<td>S041149</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Film (A4)</td>
<td>S041071</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Film (A6)</td>
<td>S041107</td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies (A4)</td>
<td>S041063</td>
</tr>
<tr>
<td>Product Description</td>
<td>Code</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>EPSON Photo Paper (A4)</td>
<td>S041140</td>
</tr>
<tr>
<td>EPSON Photo Paper (4 × 6”)</td>
<td>S041134</td>
</tr>
<tr>
<td>EPSON Photo Paper Cards (A4)</td>
<td>S041177</td>
</tr>
<tr>
<td>EPSON Photo Stickers 16 (A6)</td>
<td>S041144</td>
</tr>
<tr>
<td>EPSON Photo Stickers 4 (A6)</td>
<td>S041176</td>
</tr>
<tr>
<td>EPSON Panoramic Photo Paper (210 × 594 mm)</td>
<td>S041145</td>
</tr>
<tr>
<td>EPSON Iron-On Cool Peel Transfer Paper (A4)</td>
<td>S041154</td>
</tr>
<tr>
<td>EPSON Matte Paper-Heavyweight (A4)</td>
<td>S041259</td>
</tr>
</tbody>
</table>

**Note:**
The availability of special media varies by location.
Appendix A

Tips for Color Printing

A-BA-asics of Color ................................................. A-2
Image Resolution and Image Size ................................. A-5
Guidelines for Using Color ........................................ A-7
BAasics of Color

This section describes the basic properties of color, the relationships between colors, and how to use color to improve the quality of your printed documents.

Properties of color

Color is composed of three properties: hue, saturation, and brightness.

Hue
The name of the color, such as red, blue, or violet. The circle that represents the relationship between all hues is called the hue circle.

Saturation
The vividness of the color. This represents the amount of gray in proportion to the hue.

Brightness
The relative lightness or darkness of the color.

The method for representing these properties is called the Munsell renotation color system. The hue circle and the Munsell renotation color system are useful to understand the properties of color. See also the Color Guide.

Synchronizing monitor colors and printer colors

Your printer produces images by printing tiny patterns of ink dots on paper. It uses the colors cyan (C), magenta (M), yellow (Y), and black (K) to create a blending effect that makes you think you are seeing millions of colors. This type of color, produced by pigments that absorb some colors of light and reflect others, is called subtractive.
Note:
In theory, pure cyan, magenta, and yellow should produce black, but actually they produce a muddy brown and must be combined with black ink to produce a true black.

A cathode-ray tube (CRT) monitor produces images by illuminating color phosphors on the screen with an electron gun. (A phosphor is a substance that gives off light when irradiated.) Each screen point (pixel) has three colored phosphors: red (R), green (G), and blue (B).

Since the printer and monitor produce color images differently, and the available range of color produced by the monitor and printer are different, the image on the screen does not exactly match your printed output all of the time. If you want to adjust, or calibrate, the printed color to more closely match the on-screen color, you may have to experiment with the printer driver settings.

Additionally, color management software is available from a variety of software and monitor companies to help you match colors produced by your monitor and printer. See your image-editing software documentation for information on color matching.
The range of colors that can be displayed:

Note:
When printing a scanned image, you may find it more difficult to match colors. Because scanners create the original image data using CMYK, the data format of your image will be changed twice.

**Process of color printing**

A printer produces color images by printing tiny patterns of ink dots using CMYK colors as mentioned in the previous section. Because most ink jet printers are not able to print different gradations of the three primary colors, they must use a halftoning method in order to represent millions of colors or the gradation of colors. This method is shown in the image below.

Dithering and error diffusion are the most commonly used halftoning methods.
**Dithering**

Dithering uniformly aligns individual dots of different colored inks to create the appearance of natural colors. This method is suitable for printing documents that contain large areas of solid color, such as bar charts and graphs.

**Error diffusion**

Error diffusion blends individual colored dots with the colors of the surrounding dots to create the appearance of natural colors. By blending colored dots, the printer can achieve excellent colors and subtle color gradation. This method is best suited for printing documents that contain detailed graphics or photographic images.

---

**Image Resolution and Image Size**

The resolution of your original image affects the quality of your printouts. Generally, the higher the resolution, the better the print quality. However, keep in mind that the higher the resolution, the longer the wait for processing and printing a document.

Generally, the printed image size is in inverse proportion to the image resolution, as shown below. The larger the image size, the lower the image resolution. Conversely, the smaller the image size, the higher the image resolution.

*Note:
Some applications have a function that can correct this relationship.*
Tips for Color Printing

- 300 pixel
- 225 pixel
- 300 dpi

- 300 pixel
- 225 pixel
- 150 dpi

- 400 pixel
- 292 pixel
- 300 dpi

- 100 pixel
- 72 pixel
- 75 dpi
Since increasing the image size means decreasing the image resolution, you must take care that print quality or color tone is not degraded when working with images pasted into documents created with word processing software. To avoid print quality and color tone problems, change the size and the resolution of the image in your graphics application before pasting it into your document.

**Guidelines for Using Color**

To help you use color to maximize your document’s impact on its readers, determine the who, what, when, where, why, and how of color printing.

**Know WHO your readers are and WHAT your purpose is**

Your documents are intended to communicate information, opinions, or feelings to one or more people and also to get results. Therefore, first you need to think about who is going to see your work—will it be a customer, a co-worker, or some other person? Also you should consider what your purpose is—do you wish to advise, sell, or propose, or do you have some other purpose?

*For example:*

A marketing proposal with generous quantities of bright, fluorescent colors might fail to impress a conservative accounting firm, yet win over a music video company.

**Know WHEN to use color**

While color can enhance any document, you need to decide when color helps expand the reader’s understanding of your message and when it distracts the reader. Sometimes a serious business message is best delivered without additional colors. (Remember that white and black are colors, too.)
For example:
A job offer letter to a prospective employee works best in black and white, while a list of safety rules benefits from attention-getting color.

Decide WHERE color will most benefit your document

If you use color on every page or all over a page, you may lose not only the impact of color, but also the clarity and readability of your work. When used consistently and strategically, color breaks up the monotony of black-and-white text reading.

Note:
- Avoid placing too many color pictures, tables, or icons on a page.
- Size your color images so that they do not overpower text or graphics.
- Avoid using too much colored text. It is more difficult to read than black-on-white or white-on-black text.

Know WHY you are using color

Color adds interest and clarity, and makes documents appear easier to understand. Just as you use fonts and graphics to create appeal and capture attention, color provides an additional visual interpretation of a document that influences the reader.

For example:
An overhead presentation of sales results by territory is far more interesting and memorable if you show the figures with colored charts and graphs.

Know HOW to select colors

Determine a rule for using color throughout the document. Follow the rules below to make your color document more appealing and effective.
- Use just one hue in the hue circle to make your document unified. Modify saturation or brightness to add interest.

  or

- Use contrasting hues to make your work more eye-catching.

- Do not use complementary colors in documents.

**Note:**
*See the Color Guide for details on the hue circle.*
Appendix B

*Printer Specifications*

B-Printing ............................................................... B-2

Paper ............................................................... B-2
  Paper specifications ........................................ B-3
  Printable area ................................................ B-5

Ink Cartridges .......................................................... B-7

Safety Approvals ..................................................... B-10

System Requirements .................................................. B-11
  For PCs .......................................................... B-11
  For Macintosh computers ..................................... B-11
## Printing

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing method</td>
<td>On-demand ink jet</td>
</tr>
<tr>
<td>Nozzle configuration</td>
<td>Monochrome (black) 32 nozzles</td>
</tr>
<tr>
<td></td>
<td>Color (cyan, magenta, yellow light cyan, light magenta) 160 nozzles</td>
</tr>
<tr>
<td></td>
<td>(32 [each color] \times 5)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Maximum 1440 dpi \times 720 dpi</td>
</tr>
<tr>
<td>Print direction</td>
<td>Bidirectional with logic seeking</td>
</tr>
<tr>
<td>Control code</td>
<td>ESC/P2 Raster</td>
</tr>
<tr>
<td></td>
<td>EPSON Remote</td>
</tr>
<tr>
<td>Input buffer</td>
<td>256 KB</td>
</tr>
</tbody>
</table>

## Paper

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always test samples of paper stock before purchasing large quantities or printing large jobs.
**Paper specifications**

Single sheets:

- **Size**
  - A4 (210 mm × 297 mm)
  - A5 (148 mm × 210 mm)
  - B5 (182 mm × 257 mm)
  - Letter (216 mm × 279 mm)
  - Half letter (139.7 mm × 215.9 mm)
  - Legal (216 mm × 356 mm)
  - Executive (184.2 mm × 266.7 mm)

- **Paper types**
  - Plain bond paper, special papers distributed by EPSON

- **Thickness**
  - 0.08 mm to 0.11 mm (0.003 to 0.004 inch)

- **Weight**
  - 64 g/m² (17 lb) to 90 g/m² (24 lb)

Envelopes:

- **Size**
  - No. 10 (104.8 mm × 241 mm)
  - DL (110 mm × 220 mm)
  - C6 (114 mm × 162 mm)
  - 132 mm × 220 mm

- **Paper types**
  - Plain bond paper, air mail

- **Thickness**
  - 0.16 mm to 0.52 mm (0.006 to 0.02 inch)

- **Weight**
  - 45 g/m² (12 lb) to 75 g/m² (20 lb)

Index cards:

- **Size**
  - A6 (105 mm × 148 mm)
  - 5 × 8” (127 mm × 203 mm)
  - 8 × 10” (203 mm × 254 mm)

- **Paper types**
  - Special papers distributed by EPSON
Transparencies, glossy film:

Size  
A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)
A6 (105 mm × 148 mm)*
* for glossy film

Paper types  
Special papers distributed by EPSON

Self adhesive sheets:

Size  
A4 (210 mm × 297 mm)

Paper types  
Special paper distributed by EPSON

Matte Paper-Heavyweight:

Size  
A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)

Paper types  
Special papers distributed by EPSON

Photo paper:

Size  
A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)
100 mm × 150 mm
200 mm × 300 mm
113.6 mm × 175.4 mm

Paper types  
Special papers distributed by EPSON

Photo Stickers:

Size  
A6 (105 mm × 148 mm) with 4 or 16 frames

Paper types  
Special paper distributed by EPSON
Note:

- Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch to a higher grade of paper.

- Do not load curled or folded paper.

- Use paper under normal conditions:
  Temperature 15 to 25°C (59 to 77°F)
  Humidity 40 to 60% RH

- EPSON Ink Jet Back Light Film should be stored under the following conditions:
  Temperature 23 to 32°C (73 to 90°F)
  Humidity 40 to 60% RH

The film maybe smudged if you print below 22°C

Printable area

Single sheets (including panoramic size) and index cards
Envelopes

A: The minimum top margin is 3.0 mm (0.12"").
   When loading multiple sheets of EPSON Photo Quality Glossy Film, the minimum top margin is 30.0 mm (1.2").

B-L: The minimum left margin is 3.0 mm (0.12"").

B-R: The minimum right margin is 3.0 mm (0.12"").

C: The minimum bottom margin is 14.0 mm (0.55").

*: You can extend the minimum bottom margin to 3 mm by selecting Maximum as the Printable Area setting on the printer driver's Paper menu (for Windows) or in the Page Setup dialog box (for Macintosh). However, print quality may decline in the expanded area. Before printing large jobs using this setting, print a single sheet to confirm printout quality.

**Note:**
Always load paper into the sheet feeder short edge first. Load envelopes flap edge first with the flap side down.
## Ink Cartridges

Black ink cartridges (S020187)

<table>
<thead>
<tr>
<th>Color</th>
<th>Black</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print capacity*</td>
<td>540 pages (A4, text at 360 dpi) Standard Capacity</td>
</tr>
<tr>
<td>Cartridge life</td>
<td>2 years from production date (within 6 months after opening package, at 25°C [77°F])</td>
</tr>
<tr>
<td>Temperature Storage:</td>
<td>-20 to 40°C (-4 to 104°F)</td>
</tr>
<tr>
<td>Transit:</td>
<td>-30 to 60°C (-22 to 140°F)</td>
</tr>
<tr>
<td>Freezing:**</td>
<td>-16°C (3.2°F)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>19.8 mm (W) × 52.7 mm (D) × 38.5 mm (H)</td>
</tr>
</tbody>
</table>
### Color ink cartridge (S020193)

<table>
<thead>
<tr>
<th>Color</th>
<th>Cyan, magenta, yellow, light cyan and light magenta</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print capacity*</td>
<td>220 pages (A4, 360 dpi, 5% duty each color)</td>
</tr>
<tr>
<td>Cartridge life</td>
<td>2 years from production date</td>
</tr>
<tr>
<td></td>
<td>(within 6 months of opening the package at 25°C [77°F])</td>
</tr>
<tr>
<td>Temperature</td>
<td>Storage: -20 to 40°C (-4 to 104°F)</td>
</tr>
<tr>
<td></td>
<td>1 month at 40°C (104°F)</td>
</tr>
<tr>
<td></td>
<td>Transit: -30 to 60°C (-22 to 140°F)</td>
</tr>
<tr>
<td></td>
<td>1 month at 40°C (104°F)</td>
</tr>
<tr>
<td></td>
<td>120 hours at 60°C (140°F)</td>
</tr>
<tr>
<td></td>
<td>Freezing:** -18°C (-0.4°F)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>51.4 mm (W) × 52.7 mm (D) × 38.5 mm (H)</td>
</tr>
</tbody>
</table>

* The figure given is based upon continuous printing after ink replacement. The actual print capacity may vary, depending on how often you use the print head cleaning function and how often you turn the printer on.

** Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

---

**Caution:**

- EPSON recommends the use of original EPSON ink cartridges only. Other products not manufactured by EPSON may cause damage to your printer not covered by EPSON’s warranties.

- Do not use an ink cartridge if the date on the package has expired.
**Mechanical**

Paper feed method  Friction  
Paper path  Sheet feeder, rear entry  
Sheet feeder capacity  About 100 sheets at 64 g/m² (17 lb) paper  
Dimensions  Storage  
Width: 429 mm (16.89 inches)  
Depth: 261 mm (10.28 inches)  
Height: 168 mm (6.61 inches)  

Printing  
Width: 429 mm (16.89 inches)  
Depth: 608 mm (23.94 inches)  
Height: 293 mm (11.54 inches)  

Weight  5.2 kg (11.47 lb) without the ink cartridges  

**Electrical**

<table>
<thead>
<tr>
<th></th>
<th>120V Model</th>
<th>220-240V Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage range</td>
<td>99 to 132 V</td>
<td>198 to 264 V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
<td></td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
<td></td>
</tr>
<tr>
<td>Rated current</td>
<td>0.4 A</td>
<td>0.2 A</td>
</tr>
</tbody>
</table>
| Power consumption      | Approx. 18 W (ISO10561 Letter Pattern)  
Approx. 2.5 W in standby mode |

**Note:**  
Check the label on the back of the printer for the voltage of your printer.
Environmental

Temperature
Operation: 10 to 35°C (50 to 95°F)
Storage: -20 to 40°C (-4 to 104°F)
1 month at 40°C (104°F)
Transit:* -20 to 60°C (-4 to 140°F)
120 hours at 60°C (140°F)

Humidity
Operation: 20 to 80% RH
Storage:*,** 5 to 85% RH

* Stored in shipping container
** Without condensation

Safety Approvals

Safety standards:
U.S. model UL 1950
CSA C22.2 No.950
European model Directive 73/23/EEC
EN60950

EMC:
U.S. model FCC part 15 subpart B class B
European model Directive 89/336 /EEC
EN 55022 (CISPR Pub. 22) class B
EN 50082-1
IEC 60801-2
IEC 60801-3
IEC 60801-4
EN 61000-3-2
EN 61000-3-3

Australian model AS/NZS 3548 class B
System Requirements

For PCs

To use your printer, you need Microsoft® Windows® 95, Windows® 98, or Windows® NT 4.0 installed and a shielded, twisted-pair parallel cable connected. If you want to connect your printer to a USB port, you need a Windows 98 pre-installed PC equipped with a USB port and a shielded USB cable connected.

Your computer should also meet the following system requirements.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
<th>Recommended System</th>
</tr>
</thead>
<tbody>
<tr>
<td>i486/25 MHz for Windows 95 and NT 4.0</td>
<td>Pentium or higher processor</td>
</tr>
<tr>
<td>i486/66 MHz for Windows 98</td>
<td></td>
</tr>
<tr>
<td>16 MB RAM</td>
<td>32 MB RAM or more for Windows 95 and 98</td>
</tr>
<tr>
<td>20 MB hard disk space for Windows 95 and 98</td>
<td>64 MB or more for Windows NT 4.0</td>
</tr>
<tr>
<td>20 MB for Windows NT 4.0</td>
<td></td>
</tr>
<tr>
<td>VGA monitor</td>
<td>VGA or better monitor</td>
</tr>
</tbody>
</table>

Your computer dealer can help you update your system if it does not meet these requirements.

For Macintosh computers

To connect this printer to Apple® Macintosh® computers, you must use a USB cable.
Your Macintosh must also meet the following system requirements.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
<th>Recommended System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS 8.1</td>
<td>Mac OS 8.5.1 or later</td>
</tr>
<tr>
<td>7 MB RAM</td>
<td>15 MB RAM</td>
</tr>
<tr>
<td>9 MB RAM when background printing is turned on.</td>
<td>26 MB RAM when background printing is turned on.</td>
</tr>
</tbody>
</table>

**Note:**

- The amount of available memory varies according to the number and kind of applications that are open. To see how much memory is available, choose About This Computer from the Apple menu and refer to the memory size (listed in kilobytes) under “Largest Unused Block” (1,024K=1 MB).

- The memory requirements above are for printing on Letter size paper. These requirements may vary depending on the size of the paper, the type of application you are using, and the complexity of the document you want to print.

In addition to these system and memory requirements, you need 12 MB of free hard disk space to install your printer software. To print, you also need extra hard disk space amounting to about twice the size of the file you want to print.
The following definitions apply specifically to printers.

**application**
A software program that helps you carry out a particular task, such as word processing or financial planning.

**ASCII**
American Standard Code for Information Interchange. A standardized coding system for assigning numerical codes to letters and symbols.

**banding**
The horizontal lines that sometimes appear when printing graphics. This occurs when the print head is misaligned. See also *MicroWeave*.

**bit**
A binary digit (0 or 1), which is the smallest unit of information used by a printer or computer.

**brightness**
The lightness or darkness of an image.

**buffer**
The portion of the printer's memory used to store data before printing it.

**byte**
A unit of information consisting of eight bits.

**characters per inch (cpi)**
A measure of the size of text characters, sometimes referred to as pitch.

**CMYK**
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to create the subtractive system array of printed colors.

**color matching**
A method of processing color data so that colors displayed on a computer screen closely match colors in printouts. A variety of color-matching software is available. See also *ColorSync*.

**ColorSync**
Macintosh software that is designed to help you get WYSIWYG (what you see is what you get) color output. This software prints colors as you see them on your screen.

**cpi**
See *characters per inch*. 
**default**
A value or setting that takes effect when the equipment is turned on, reset, or initialized.

**dithering**
A halftoning method in which dots are arranged in an orderly pattern. Dithering works best for printing images with solid colors, such as charts and graphs. See also halftoning.

**DMA**
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU and allows direct communication between a computer and peripheral devices (like printers), and between one peripheral device and another.

**dpi**
Dots per inch. The dpi measures the resolution. See also resolution.

**drive**
A memory device, such as CD-ROM, hard disk, or floppy disk. In Windows, a letter is assigned to each drive for easy management.

**driver**
A software program that sends instructions to a computer peripheral to tell it what to do. For example, your printer driver accepts print data from your word processor application and sends instructions to the printer on how to print this data.

**economy printing**
Printing in which images are printed with fewer dots to save ink.

**error diffusion**
Error diffusion blends individual colored dots with the colors of the surrounding dots to create the appearance of natural colors. By blending colored dots, the printer can achieve excellent colors and subtle color gradation. This method is best suited for printing documents that contain detailed graphics or photographic images.

**ESC/P**
Abbreviation for EPSON Standard Code for Printers, the system of commands your computer uses to control your printer. It is standard for all EPSON printers and is supported by most application software for personal computers.

**Finest detail**
This printer driver setting automatically makes your printout sharper and clearer, especially for text. Be aware that this may increase the time required for printing.

**font**
A style of type designated by a family name.
**grayscale**
A scale of shades of gray from black to white. Grayscale is used to represent colors when printing with black ink only.

**halftones**
Patterns of black or colored dots used to reproduce an image.

**halftoning**
A method of using dot patterns to represent an image. Halftoning makes it possible to produce varying shades of gray using only black dots, or a nearly infinite array of colors using only a few colors of dots. See also halftones.

**high speed printing**
Printing in which images are printed in both directions. This provides faster printing.

**initialization**
Returns the printer to its defaults (fixed set of conditions). This happens every time you turn on the printer or reset the printer.

**ink cartridge**
Contains the ink your printer uses when printing.

**ink jet**
A method of printing in which each letter or symbol is formed by precisely spraying ink onto paper.

**interface**
The connection between the computer and the printer. A parallel interface transmits data one character or code at a time. A serial interface transmits data one bit at a time.

**interface cable**
The cable that connects the computer and the printer.

**local printer**
The printer connected to the computer’s port directly by interface cable.

**media**
Materials upon which data is printed, such as envelopes, plain paper, special paper, and transparency film.

**memory**
The part of the printer’s electronic system that is used to store information (data). Some information is fixed and is used to control how the printer operates. Information that is sent to the printer from the computer is stored in memory temporarily. See also RAM and ROM.

**MicroWeave**
Printing in which images are printed in finer increments to reduce the possibility of banding and to produce laser-like images. See also banding.
**monochrome**  
This means printing with only one color of ink, which is generally black ink.

**nozzle**  
Fine tubes in the print head through which ink is sprayed on the page. Print quality may decline if the print head nozzles are clogged.

**operation check**  
A method for checking the operation of the printer. When you perform a printer operation check, the printer prints the ROM version, code page, ink counter code, and a nozzle check pattern.

**parallel interface**  
See *interface*.

**port**  
An interface channel through which data is transmitted between devices.

**printable area**  
The area of a page on which the printer can print. It is smaller than the physical size of the page due to margins.

**printer driver**  
A software program that sends commands for using the features of a particular printer. Often shortened to “driver”.

**print queue**  
If your printer is connected to a network, print jobs that are sent to the printer while it is busy are stored in a waiting line, or print queue, until they can be printed.

**RAM**  
Random Access Memory. The portion of the printer’s memory used as a buffer and for storing user-defined characters. All data stored in RAM is lost when the printer is turned off.

**reset**  
To return a printer to its defaults by turning the printer off and then back on.

**resolution**  
The number of dots per inch used to represent an image.

**ROM**  
Read Only Memory. A portion of memory that can only be read and cannot be used for data storage. ROM retains its contents when you turn off the printer.

**RGB**  
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube (CRT) monitor’s electron gun, are used to create the additive array of screen colors.
**serial interface**
See *interface*.

**spool**
The first step in printing, in which the printer driver converts the print data into codes that your printer understands. This data is then sent directly to the printer or to the print server.

**spool manager**
The software program that converts print data into codes that your printer understands. See also *spool*.

**status monitor**
The software program that allows you to check the printer’s status.

**subtractive colors**
Colors produced by pigments that absorb some colors of light and reflect others. See also CMYK.

**USB interface**
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral devices (such as keyboards, mice, and printers) to the computer through a single, general-purpose port. The use of USB hubs allows you to add additional ports. See also *interface*.

**WYSIWIG**
What-you-see-is-what-you-get. This term is used to describe printout that looks exactly like it appears on screen.